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Notice

© Keysight Technologies, Inc. 1983-2016
1400 Fountaingrove Pkwy., Santa Rosa, CA 95403-1738, United States

All rights reserved.

No part of this documentation may be reproduced in any form or by any means (including electronic storage
and retrieval or translation into a foreign language) without prior agreement and written consent from
Keysight Technologies, Inc. as governed by United States and international copyright laws.

Restricted Rights Legend

If software is for use in the performance of a U.S. Government prime contract or subcontract, Software is
delivered and licensed as "Commercial computer software" as defined in DFAR 252.227-7014 (June 1995),
or as a "commercial item" as defined in FAR 2.101(a) or as "Restricted computer software" as defined in FAR
52.227-19 (June 1987) or any equivalent agency regulation or contract clause.

Use, duplication or disclosure of Software is subject to Keysight Technologies' standard commercial license
terms, and non-DOD Departments and Agencies of the U.S. Government will receive no greater than
Restricted Rights as defined in FAR 52.227-19(c)(1-2) (June 1987). U.S. Government users will receive no
greater than Limited Rights as defined in FAR 52.227-14 (June 1987) or DFAR 252.227-7015 (b)(2)
(November 1995), as applicable in any technical data.

Acknowledgments
Layout Boolean Engine by Klaas Holwerda, v1.7 http://boolean.klaasholwerda.nl/bool.html

FreeType Project, Copyright (c) 1996-1999 by David Turner, Robert Wilhelm, and Werner Lemberg.
QuestAgent search engine (c) 2000-2002, JObjects.

Portions of the code Copyright (c) 1990-1996

The Regents of the University of California. All rights reserved. Permission is hereby granted, without written
agreement and without license or royalty fees, to use, modify and distribute the Ptolemy software and its
documentation for any purpose, provided that the above copyright notice and the following two paragraphs
appear in all copies of the software and documentation.

In no event shall the University of California be liable to any party for direct, indirect, special, incidental, or
consequential damages arising out of the use of this software and its documentation, even if the University
of California has been advised of the possibility of such damage.

The University of California specifically disclaims any warranties, including, but not limited to, the implied
warranties of merchantability and fitness for a particular purpose. The software provided hereunder is on an
"as is" basis and the University of California has no obligation to provide maintenance, support, updates,
enhancements, or modifications.

Portions of this product include the SystemC software licensed under Open Source terms, which are
available for download at http://systemc.org/. This software is redistributed by Keysight. The Contributors of
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the SystemC software provide this software "as is" and offer no warranty of any kind, express or implied,
including without limitation warranties or conditions or title and non-infringement, and implied warranties or
conditions merchantability and fitness for a particular purpose. Contributors shall not be liable for any
damages of any kind including without limitation direct, indirect, special, incidental and consequential
damages, such as lost profits. Any provisions that differ from this disclaimer are offered by Keysight only.

Motif is a trademark of the Open Software Foundation.
Netscape is a trademark of Netscape Communications Corporation.
UNIX is a registered trademark of the Open Group.

Microsoft, Windows, Windows NT, Windows 2000, and Windows Internet Explorer are registered trademarks
of Microsoft Corporation in the United States and other countries.

Pentium is a registered trademark of Intel Corporation.
Acrobat, PDF, and PostScript are registered trademarks of Adobe Systems Incorporated.

FLEXIm and FLEXnet are registered trademarks of Flexera Software LLC Terms of Use for Flexera Software
information can be found at http://www.flexerasoftware.com/company/about/terms.htm

Netscape Portable Runtime (NSPR), Copyright (c) 1998-2003 The Mozilla Organization. A copy of the Mozilla
Public License is at http://www.mozilla.org/MPL/

FFTW, The Fastest Fourier Transform in the West, Copyright (c) 1997-1999 Massachusetts Institute of
Technology. All rights reserved.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of
their respective owners.

Cadence, Allegro, Assura, Dracula, SKILL, Spectre, and Virtuoso are registered trademarks of Cadence
Design Systems, Inc. in the United States and/or other jurisdictions.

Mentor, Mentor Graphics, Board Station, Calibre, and Expedition are registered trademarks of Mentor
Graphics Corporation in the United States and other countries.

SystemC is a registered trademark of Open SystemC Initiative, Inc. in the United States and other countries
and is used with permission.

Gradient, HeatWave and FireBolt are trademarks of Gradient Design Automation Inc.
The following third-party libraries are used by the NlogN Momentum solver:

Metis 4.0, Copyright © 1998, Regents of the University of Minnesota", http://www.cs.umn.edu/~metis,
METIS was written by George Karypis (karypis@cs.umn.edu).

Intel@ Math Kernel Library, http://www.intel.com/software/products/mkl
HSPICE is a registered trademark of Synopsys, Inc. in the United States and/or other countries.

DWG and DXF are registered trademarks of Autodesk, Inc. in the United States and/or other countries.


http://www.flexerasoftware.com/company/about/terms.htm
http://www.mozilla.org/MPL/
http://www.cs.umn.edu/~metis
http://www.intel.com/software/products/mkl

MATLAB is a registered trademark of The MathWorks, Inc. in the United States and/or other countries.
SuperLU_MT version 2.0

SuperLU Copyright: Copyright © 2003, The Regents of the University of California, through Lawrence
Berkeley National Laboratory (subject to receipt of any required approvals from U.S. Dept. of Energy). All
rights reserved.

SuperLU Disclaimer: THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

7-zip
7-Zip Copyright: Copyright (C) 1999-2009 Igor Pavlov.
Licenses for files are:

1. 7z.dll: GNU LGPL + unRAR restriction.
2. All other files: GNU LGPL.

7-zip License: This library is free software; you can redistribute it and/or modify it under the terms of the
GNU Lesser General Public License as published by the Free Software Foundation; either version 2.1 of the
License, or (at your option) any later version. This library is distributed in the hope that it will be useful,but
WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A
PARTICULAR PURPOSE. See the GNU Lesser General Public License for more details. You should have
received a copy of the GNU Lesser General Public License along with this library; if not, write to the Free
Software Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA 02111-1307 USA.

unRAR copyright: The decompression engine for RAR archives was developed using source code of unRAR
program.All copyrights to original unRAR code are owned by Alexander Roshal.

unRAR License: The unRAR sources cannot be used to re-create the RAR compression algorithm, which is
proprietary. Distribution of modified unRAR sources in separate form or as a part of other software is
permitted, provided that it is clearly stated in the documentation and source comments that the code may
not be used to develop a RAR (WinRAR) compatible archiver.

7-zip Availability: http://www.7-zip.org/
AMD Version 2.2
AMD Notice: The AMD code was modified. Used by permission.

AMD copyright: AMD Version 2.2, Copyright © 2007 by Timothy A. Davis, Patrick R. Amestoy, and lain S.
Duff. All Rights Reserved.
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AMD License: Your use or distribution of AMD or any modified version of AMD implies that you agree to this
License. This library is free software; you can redistribute it and/or modify it under the terms of the GNU
Lesser General Public License as published by the Free Software Foundation; either version 2.1 of the
License, or (at your option) any later version. This library is distributed in the hope that it will be useful, but
WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A
PARTICULAR PURPOSE. See the GNU Lesser General Public License for more details. You should have
received a copy of the GNU Lesser General Public License along with this library; if not, write to the Free
Software Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA Permission is hereby
granted to use or copy this program under the terms of the GNU LGPL, provided that the Copyright, this
License, and the Availability of the original version is retained on all copies.User documentation of any code
that uses this code or any modified version of this code must cite the Copyright, this License, the Availability
note, and "Used by permission." Permission to modify the code and to distribute modified code is granted,
provided the Copyright, this License, and the Availability note are retained, and a notice that the code was
modified is included.

AMD Availability: http://www.cise.ufl.edu/research/sparse/amd

UMFPACK 5.0.2

UMFPACK Notice: The UMFPACK code was modified. Used by permission.

UMFPACK Copyright: UMFPACK Copyright © 1995-2006 by Timothy A. Davis. All Rights Reserved.

UMFPACK License: Your use or distribution of UMFPACK or any modified version of UMFPACK implies that
you agree to this License. This library is free software; you can redistribute it and/or modify it under the
terms of the GNU Lesser General Public License as published by the Free Software Foundation; either version
2.1 of the License, or (at your option) any later version. This library is distributed in the hope that it will be
useful, but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS
FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License for more details. You should have
received a copy of the GNU Lesser General Public License along with this library; if not, write to the Free
Software Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA Permission is hereby
granted to use or copy this program under the terms of the GNU LGPL, provided that the Copyright, this
License, and the Availability of the original version is retained on all copies. User documentation of any code
that uses this code or any modified version of this code must cite the Copyright, this License, the Availability
note, and "Used by permission." Permission to modify the code and to distribute modified code is granted,
provided the Copyright, this License, and the Availability note are retained, and a notice that the code was
modified is included.

UMFPACK Availability: http://www.cise.ufl.edu/research/sparse/umfpack UMFPACK (including versions
2.2.1 and earlier, in FORTRAN) is available at http://www.cise.ufl.edu/research/sparse. MA38 is available in
the Harwell Subroutine Library. This version of UMFPACK includes a modified form of COLAMD Version 2.0,
originally released on Jan. 31, 2000, also available at http://www.cise.ufl.edu/research/sparse. COLAMD V2.
0 is also incorporated as a built-in function in MATLAB version 6.1, by The MathWorks, Inc. http://www.
mathworks.com. COLAMD V1.0 appears as a column-preordering in SuperLU (SuperLU is available at
http://www.netlib.org). UMFPACK v4.0 is a built-in routine in MATLAB 6.5. UMFPACK v4.3 is a built-in
routine in MATLAB 7.1.

Errata
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The ADS product may contain references to "HP" or "HPEESOF" such as in file names and directory names.
The business entity formerly known as "HP EEsof" is now part of Keysight Technologies and is known as
"Keysight EEsof". To avoid broken functionality and to maintain backward compatibility for our customers,
we did not change all the names and labels that contain "HP" or "HPEESOF" references.

Qt Version 4.8.4
Qt Notice: The Qt code was modified. Used by permission.

Qt Version 4.8.4, Copyright (C) 2014 Digia Plc and/or its subsidiary(-ies). All Rights Reserved. Contact:
http://www.qt-project.org/legal

Qt License: http://qt-project.org/doc/qt-4.8/lgpl.html. Your use or distribution of Qt or any modified version
of Qt implies that you agree to this License. This library is free software; you can redistribute it and/or modify
it under the terms of the GNU Lesser General Public License as published by the Free Software Foundation;
either version 2.1 of the License, or (at your option) any later version. This library is distributed in the hope
that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License
for more details. You should have received a copy of the GNU Lesser General Public License along with this
library; if not, write to the Free Software Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-
1301 USA Permission is hereby granted to use or copy this program under the terms of the GNU LGPL,
provided that the Copyright, this License, and the Availability of the original version is retained on all copies.
User documentation of any code that uses this code or any modified version of this code must cite the
Copyright, this License, the Availability note, and "Used by permission." Permission to modify the code and to
distribute modified code is granted, provided the Copyright, this License, and the Availability note are
retained, and a notice that the code was modified is included.

Qt Availability: http://www.qgtsoftware.com/downloads

Patches Applied to Qt can be found in the installation at: $HPEESOF_DIR/prod/licenses/thirdparty/qt
/patches.

You may also contact Brian Buchanan at Keysight Inc. at brian_buchanan@keysight.com for more
information.

The HiSIM_HV source code, and all copyrights, trade secrets or other intellectual property rights in and to
the source code, is owned by Hiroshima University and/or STARC.

HDF5

HDF5 Notice: The HDF5 code was modified. Used by permission.

HDF5 Copyright: Copyright 2006-2013 by The HDF Group.

HDF5 License:

Copyright Notice and License Terms for HDF5 (Hierarchical Data Format 5) Software Library and Utilities
HDF5 (Hierarchical Data Format 5) Software Library and Utilities

Copyright 2006-2013 by The HDF Group.
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NCSA HDF5 (Hierarchical Data Format 5) Software Library and Utilities
Copyright 1998-2006 by the Board of Trustees of the University of Illinois.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted for any
purpose (including commercial purposes) provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions, and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and
the following disclaimer in the documentation and/or materials provided with the distribution.

3. In addition, redistributions of modified forms of the source or binary code must carry prominent
notices stating that the original code was changed and the date of the change.

4. All publications or advertising materials mentioning features or use of this software are asked, but not
required, to acknowledge that it was developed by The HDF Group and by the National Center for
Supercomputing Applications at the University of Illinois at Urbana-Champaign and credit the
contributors.

5. Neither the name of The HDF Group, the name of the University, nor the name of any Contributor may
be used to endorse or promote products derived from this software without specific prior written
permission from The HDF Group, the University, or the Contributor, respectively.

libpng

libpng Copyright: libpng versions 1.2.6, August 15, 2004, through 1.6.3, July 18, 2013, are Copyright (c)
2004, 2006-2013.

libpng License: This copy of the libpng notices is provided for your convenience. In case of any discrepancy
between this copy and the notices in the file png.h that is included in the libpng distribution, the latter shall
prevail.

COPYRIGHT NOTICE, DISCLAIMER, and LICENSE:

If you modify libpng you may insert additional notices immediately following this sentence.

This code is released under the libpng license.

libpng versions 1.2.6, August 15, 2004, through 1.6.3, July 18, 2013, are Copyright (c) 2004, 2006-2013
Glenn Randers-Pehrson, and are distributed according to the same disclaimer and license as libpng-1.2.5
with the following individual added to the list of Contributing Authors, Cosmin Truta

libpng versions 1.0.7, July 1, 2000, through 1.2.5 - October 3, 2002, are Copyright (c) 2000-2002 Glenn
Randers-Pehrson, and are distributed according to the same disclaimer and license as libpng-1.0.6 with the
following individuals added to the list of Contributing Authors

Simon-Pierre Cadieux, Eric S. Raymond, Gilles Vollant and with the following additions to the disclaimer:
There is no warranty against interference with your enjoyment of the library or against infringement. There is
no warranty that our efforts or the library will fulfill any of your particular purposes or needs. This library is
provided with all faults, and the entire risk of satisfactory quality, performance, accuracy, and effort is with
the user.



libpng versions 0.97, January 1998, through 1.0.6, March 20, 2000, are Copyright (c) 1998, 1999 Glenn
Randers-Pehrson, and are distributed according to the same disclaimer and license as libpng-0.96, with the
following individuals added to the list of Contributing Authors: Tom Lane, Glenn Randers-Pehrson, Willem
van Schaik

libpng versions 0.89, June 1996, through 0.96, May 1997, are Copyright (c) 1996, 1997 Andreas Dilger
Distributed according to the same disclaimer and license as libpng-0.88, with the following individuals added
to the list of Contributing Authors: John Bowler, Kevin Bracey, Sam Bushell, Magnus Holmgren, Greg
Roelofs, Tom Tanner

libpng versions 0.5, May 1995, through 0.88, January 1996, are Copyright (c) 1995, 1996 Guy Eric Schalnat,
Group 42, Inc.

For the purposes of this copyright and license, "Contributing Authors" is defined as the following set of
individuals: Andreas Dilger, Dave Martindale, Guy Eric Schalnat, Paul Schmidt, Tim Wegner

The PNG Reference Library is supplied "AS IS". The Contributing Authors and Group 42, Inc. disclaim all
warranties, expressed or implied, including, without limitation, the warranties of merchantability and of
fitness for any purpose. The Contributing Authors and Group 42, Inc. assume no liability for direct, indirect,
incidental, special, exemplary, or consequential damages, which may result from the use of the PNG
Reference Library, even if advised of the possibility of such damage.

Permission is hereby granted to use, copy, modify, and distribute this source code, or portions hereof, for any
purpose, without fee, subject to the following restrictions:

1. The origin of this source code must not be misrepresented.

2. Altered versions must be plainly marked as such and must not be misrepresented as being the original
source.

3. This Copyright notice may not be removed or altered from any source or altered source distribution.

The Contributing Authors and Group 42, Inc. specifically permit, without fee, and encourage the use of this
source code as a component to supporting the PNG file format in commercial products. If you use this
source code in a product, acknowledgment is not required but would be appreciated.

OpenSSL

The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the OpenSSL License and the
original SSLeay license apply to the toolkit. See below for the actual license texts. Actually both licenses are
BSD-style Open Source licenses. In case of any license issues related to OpenSSL please contact openssl-
core@openssl.org.

OpenSSL License

Copyright (c) 1998-2011 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.



3. All advertising materials mentioning features or use of this software must display the following
acknowledgment: "This product includes software developed by the OpenSSL Project for use in the
OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote
products derived from this software without prior written permission. For written permission, please
contact openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their
names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment: "This product
includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.
openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS" AND ANY EXPRESSED OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR
ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product
includes software written by Tim Hudson (tjh@cryptsoft.com).

Original SSLeay License
Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com).

The implementation was written so as to conform with Netscapes SSL. This library is free for commercial and
non-commercial use as long as the following conditions are aheared to. The following conditions apply to all
code found in this distribution, be it the RC4, RSA, lhash, DES, etc., code; not just the SSL code. The SSL
documentation included with this distribution is covered by the same copyright terms except that the holder
is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be removed. If this
package is used in a product, Eric Young should be given attribution as the author of the parts of the library
used. This can be in the form of a textual message at program startup or in documentation (online or textual)
provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.
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3. All advertising materials mentioning features or use of this software must display the following
acknowledgement: "This product includes cryptographic software written by Eric Young (
eay@cryptsoft.com)" The word 'cryptographic' can be left out if the rouines from the library being
used are not cryptographic related.

4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application
code) you must include an acknowledgement: "This product includes software written by Tim Hudson (
tih@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

The licence and distribution terms for any publically available version or derivative of this code cannot be
changed. i.e. this code cannot simply be copied and put under another distribution license \[including the
GNU Public Licence.]

Growl GNTP support:
[The "BSD licence"] Copyright (c) 2009-2010 Yasuhiro Matsumoto
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. The name of the author may not be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Cuda
Cuda Redistributable Software - 1.8. Attachment A



In connection with Section 1.2.1.1 of this Agreement, the following files may be redistributed with software
applications developed by Licensee, including certain variations of these files that have version number or
architecture specific information embedded in the file name - as an example only, for release version 6.0 of
the 64-bit Windows software, the file cudart64_60.dll is redistributable.

Component : CUDA Runtime

Windows : cudart.dll, cudart_static.lib
MacOS : libcudart.dylib, libcudart_static.a
Linux : libcudart.so, libcudart_static.a
Android : libcudart.so, libcudart_static.a

Component : CUDA FFT Library
Windows : cufft.dll

MacOS : libcufft.dylib

Linux : libcufft.so

Android : libcufft.so

Component : CUDA BLAS Library
Windows : cublas.dll

MacOS : libcublas.dylib

Linux : libcublas.so

Android : libcublas.so

Component : CUDA Sparse Matrix Library
Windows : cusparse.dll

MacOs : libcusparse.dylib

Linux : libcusparse.so

Android : libcusparse.so

Component : CUDA Random Number Generation Library
Windows : curand.dll

MacOs : libcurand.dylib

Linux : libcurand.so

Android : libcurand.so

Component : NVIDIA Performance Primitives Library
Windows : nppc.dll, nppi.dll, npps.dll

MacOs : libnppc.dylib, libnppi.dylib, libnpps.dylib
Linux : libnppc.so, libnppi.so, libnpps.so

Android : libnppc.so, libnppi.so, libnpps.so

Component : NVIDIA Optimizing Compiler Library
Windows : nvwm.dll

MacOs : libnvvm.dylib

Linux : libnvvm.so

Component : NVIDIA Common Device Math Functions Library

Windows : libdevice.compute_20.bc, libdevice.compute_30.bc, libdevice.compute_35.bc
MacOs : libdevice.compute_20.bc, libdevice.compute_30.bc, libdevice.compute_35.bc
Linux : libdevice.compute_20.bc, libdevice.compute_30.bc, libdevice.compute_35.bc



Component : CUDA Occupancy Calculation Header Library
All : cuda_occupancy.h

Read more at: http://docs.nvidia.com/cuda/eula/index.html#ixzz30CrknWfU

Warranty The material contained in this document is provided "as is", and is subject to being changed,
without notice, in future editions. Further, to the maximum extent permitted by applicable law, Keysight
disclaims all warranties, either express or implied, with regard to this documentation and any information
contained herein, including but not limited to the implied warranties of merchantability and fitness for a
particular purpose. Keysight shall not be liable for errors or for incidental or consequential damages in
connection with the furnishing, use, or performance of this document or of any information contained herein.
Should Keysight and the user have a separate written agreement with warranty terms covering the material
in this document that conflict with these terms, the warranty terms in the separate agreement shall control.
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SIPro and PIPro

SIPro/PlIPro

SIPro/PIPro is a simulation and analysis tool that enables you to evaluate the signal integrity (SI) performance of signal

nets and the power integrity (PI) performance of power distribution networks (PDNs). This tool provides several

capabilities to perform pre-layout analyses and post-layout verifications. The following figure illustrates the analysis

setup and results visualization environment of SIPro/PIPro:

Layout

** schematic

Analysis Setup and Results Visualization Environment

T o

Manage Nets, VRMS, sinks,
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Four analysis engines

® Getting Started with SIPro and PIPro

® Creating an SIPro and PIPro Setup

® SIPro and PIPro Setup Window Overview

® Using Component Models

® PIPro Analysis

© PIPro Analysis Setup Overview

© Tutorial-Performing a PI-DC and PI-AC Analysis

© PI-DC Static IR Drop Analysis

® Creating a PI-DC Analysis Setup

® Viewing PI-DC Analysis Results

© PI-AC Dynamic IR Drop Analysis

® Creating a PI-AC Analysis Setup

® Viewing PI-AC Analysis Results

© PI-PPR Analysis

® Creating a PI-PPR Analysis Setup

® Viewing PI-PPR Analysis Results
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® SIPro Analysis
© Tutorial-Performing Power Aware S| Analysis
© Creating a Power Aware Sl Analysis Setup

© Viewing Power Aware S| Analysis Results

® SIPro and PIPro Videos
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Getting Started with SIPro/PIPro

Using the SIPro/PIPro simulation and analysis tool, you can evaluate the signal integrity (SI) performance of signal nets

and the power integrity (PI) performance of power distribution networks (PDNs). It enables you to perform pre-layout

analysis and post-layout verifications. SIPro/PIPro provides the following analysis capabilities:

® PI-DC Analysis

® PI-AC Analysis

® Power Plane Resonance Analysis

® Power-Aware Signal Integrity Analysis

The following figure illustrates the analysis setup and results visualization environment of SIPro/PIPro:

Analysis Setup and Results Visualization Environment

7% et

T

Manage Nets, VPMSs, sinks,

e et

)

JE

3D Layout View and Results
Visualization

L— Set up and Run Aanalysis

SIPro/PIPro Workflow

PI-DC

IR Drop

PI-AC
PDN Impedance

Power Flane
Resonances

Power-Aware
Signal Integrity

Four analysis engines

The workflow for evaluating the Sl or Pl performance of a layout design is displayed in the following figure:

22



SIPro and PIPro

Create or import a design

Open the layout in SIPro/PIPro

Set up an analysis

Run the analysis and view results

Generate a schematic

Schematic

Simulate the system behavior

Analysis Capabilities

PI-DC Analysis

A PI-DC analysis computes the voltage, IR drop (voltage drop), current, and power loss density in the power supply nets.
It helps you to identify the IC and connector pins or stitching vias drawing large amounts of current at DC operating
conditions. Due to excessive voltage drop, the power supply voltage at the IC might fall below the recommended
minimum voltage. This can cause malfunctioning of the IC. Excessive current density in the perforated power supply rails
can generate excessive heat, which might lead to board failures due to delamination or fusing. Also, excessive current in
the stitching vias can lead to via failures losing connection. Any number of power supply nets with source and sink

models can be simulated together.

PI-AC Analysis

A PI-AC analysis computes the impedance for the IC current loads over a broad frequency range. It helps you to identify
whether the power distribution network (PDN) provides a low impedance path from the Voltage Regulator Module (VRM)
to the IC. An excessive impedance in a certain frequency range can generate excessive voltage noise, also called dynamic
IR drop, when the IC power supply pins draw large amounts of transient current, required for /0 or core logic switching,

at rates that fall into that frequency range.
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Power Plane Resonance Analysis

A power plane resonance (PPR) analysis computes the self-resonant frequencies and corresponding Q-factors of the
power distribution network (PDN). It helps you to identify optimal placement of ICs, decoupling capacitors and stitching
vias. A power plane resonance can disturb sensitive analog circuitry and generate excessive radiation. This can cause

that EMC specifications cannot be met.

Power-Aware Signal Integrity Analysis

A power-aware signal integrity analysis computes a model characterizing the behavior of signal and power networks. The
model can be assesed from within the SIPro window and can be used as input for further analysis in circuit simulation, e.

g. channel or transient simulations.

For PI-AC, Power Plane Resonance Analysis and Power-Aware Signal Integrity Analysis, the
minimal recommended memory requirement is 4 GB, preferrably higher. There is a fixed
overhead cost even for small designs of 1.5-2GB. The memory growth as the simulated designs
get larger is close to linear. The memory requirement is not dependend on the requested

frequency range.

Design Assumptions

The recommended starting point for using SIPro and PIPro is a layout with instantiated components. A flat layout with
top level pins can be used, but an analysis setup is much easier when the component instances are available. Net names
play a key role in the analysis setup. The file import in ADS for following design transfer formats preserves the net names
when that information is provided by the third party tool. Verify the file export options in the third part tool to pass as

much design information as possible.

Vendor Tool Recommended

Design Transfer Format

Altium®
Designer ODB++
Cadence®
Allegro PCB BRD or ODB++
APD ADFI
SiP ADFI
OrCAD ODB++
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SIPro and PIPro

Mentor Graphics®

Expedition

PADS

BoardStation

Zuken™

CR5000

CR8000

CADSTAR

Other Formats

ODB++

ODB++

ODB++

ODB++

ODB++

ODB++

ABL

The substrate (layer stackup) defines the arrangement and materials of the signal and power plane layers in a multi-layer

board or package design. Always verify the substrate definition in case of a design transfer from a third party tool. The

third party tool often does not export the full substrate specification. Once you have the layout with components, net

names and substrate, you are ready to open the SIPro/PIPro Setup window.

Example Workspace

An example workspace to get started with SIPro and PIPro is provided with ADS, see examples/HSD

/SIPro_PIPro_Getting_Started_Example_wrk.7zads. The workspace contains a Samsung DDR3 UDIMM memory card. The

design files are from the JEDEC (www.jedec.com). The design consists of a 6 layer board with single power rail for core

and I/0 buffers.
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Creating an SIPro and PIPro Setup

To analyze the Sl and Pl performance, you can create an SIPro/PIPro setup in the following ways:

® Create a new setup

® Open an existing setup

Creating a New SIPro/PIPro Setup

To create a new SIPro/PIPro setup:

1. Open a Layout window in ADS.

2. Select Tools > SIPro/PIPro > New Setup from a Layout window to create a new setup. The New SIPro/PIPro Setup

window is displayed, as shown in the following figure:

3. Specify the Cellview name.

New SIPro/PIPro Setup

L9 o)

Cellview: PC3-10600-UDIMM:PC3-10600-UDIMM:  sipiSetupd]

Layout: PC3-10600-UDIMM: PC3-10600-UDIMM:layout

Substrate: [ -_. PC3-10600-UDIMM:PC3-10800-UDIMM

Lo |

4. Select the required substrate.

5. click OK. A new SIPro/PIPro Setup window is displayed, where you can set up and run an analysis.

=
VDD_GND_DC
- [] VDD_GND_AC
- [31] DQ_GNDLIL_U19
¥ Scripts
= Graphs.

a

View & x
Transhucent View: | |

Highight Nets: [F) [F) J* &F

M n
PCA-RDIMM_V090_RC_FO_20131106 [PC4-RDIMM _V090_RC_FO_20131106 _lib:PC4-RDIMM_V090_RC_F0_20131106:sipiSetup] (SIPro/PIPro Setup) l_l_ﬂﬂ ]
Fle Edit Yiew Jook Hep = ¥ ¢ [] -
= T Lo =2l
®OE= View Geometry
4 [ Design ®
4 B PC4-ROIMM _V090_RC_F0_201... Simdatons
O Mets T @
€ Components Y Farmws‘
52 Substrate ~
O Pins T Scripting
4 | | Definitions
> [ Materials
i n
SIPro/PIPro Setup & x

Idle
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m The SIPro/PIPro window cannot be used for ADS layout designs that contain the following

features:

® Derived layers

® 3D EMPro components
® Slot layers

® Multi-technology setup

In addition, the SIPro/PIPro setup assumes meaningful and consistent net definitions in the

design.

Opening an Existing SIPro/PIPro Setup

The Sl and/or Pl analysis setup data for a specific design is stored in a cell view of the “SIPro/PIPro Setup” type .
The default view name is “sipiSetup”. These views are registered with OA and behave like “Schematic” and “Layout”
views. You can perform various tasks such as, renaming, copying, moving, and archiving. A single view can contain

multiple analysis setups, such as PI-DC and PI-AC analysis setup.

To open an existing setup:

1. Open a Layout window in ADS.

2. Select Tools > SIPro/PIPro > Open Setup from a Layout window to open an existing setup. The Select one view

window is displayed, as shown in the following figure:

3. Select the required view.

Select one view:l ﬁ1

sipiSetup
sipisetupl

4. Click OK. The SIPro/PIPro Setup window is displayed.

Alternatively, you can open an existing setup by clicking the sipiSetup view in the Main window.

PN T3 PC3-10600-UDIMM
layout
sipiSetup

SIPro/PIPro Setup Window Elements

The SIPro/PIPro Setup window consists of the following elements:
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GUI Element

Project Panel

Geometry Window

Simulation Window

Parameters Window

Scripting Window

Menus

Workspace Tabs

Description

Consists of a panel that provides a tree-structured
representation of the design Parts, Definitions, Graphs,

and Analyses.

Comprises the main viewing area. It enables you to

perform various viewing operations.

Allows you to monitor analyses sent the calculation

engine.

Enables you to create, edit, and delete parameters that

can be referenced in an analysis setup

Allows you to view, edit, and execute scripts.

Provides File, Edit, View, Tools, and Help menus.

Provides Geometry, Simulation, Parameters, and Scripting

tabs to control the associated windows

For more information about SIPro/PIPro windows, see Workspace Windows.
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SIPro and PIPro Setup Window Overview

SIPro/PIPro Setup Window Overview

Contents

® SIPro and PIPro Project Panel
® Workspace Windows

® Configuring SIPro and PIPro
® Add-on Manager

® Setup Options for Customizing Results

SIPro and PIPro Project Panel

In the SIPro/PIPro Setup window, the Project panel provides a tree-structured representation of a design. You can use
the Project panel to define a specific Pl or Sl analysis setup, to run the analysis and to review results. The Project panel

toolbar enables you to show or hide specific items of a design. The following figure displays a project panel:
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Project

woEe

= ) Design

EI--- PC3-10600-UDIMM:PC3-1060..,
G P Mets Y
._'IS Components T

-_ Substrate
“{Jr Pins
= L_] Definitions

& [

Materials

o LY

EIEl Analysis 1

B = VRMs

G- & Sinks

_E'?.I Component Models
% Opticns...

ig Run

El- 70 Results

= [A2] Analysis 2

== VRMs

-~ & Sinks

_‘_"‘-'I Component Models

% Options...
-4 Run

E- T Results

& Analysis 3
- @ Analysis 4

% Scripts

:'-:al Graphs

A project panel consists of the following components:

® Design

® Definitions
® Analyses
® Scripts

® Graphs

........
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Design
The Design list displays the physical parts of the design-under-test. Currently, this is the layout view from which the SIPro

/PIPro Setup was opened, no other parts can be added. The layout tree contains four items: Nets, Components, Substrate

and Pins.
= ) Design
= PC3-10600-UDIMM:PC3-10600-UDIMM:layout
G- ol Nets T
€| Components r
52 Substrate
i Pins

Nets

All nets in the layout view are listed. Each net gets a type, ‘Power’, ‘Ground’, ‘Signal’ or ‘Undefined’ assigned. The nets are

sorted by type.

Type Icon
Power o
Ground o
Signal dr
Undefined oy

Verify that the nets that you plan to simulate have been typed correctly. Even though SIPro
/PIPro attempts to automatically identify the net type, the algorithm can miss nets with arbitrary

names.

Changing Net Type

To change a net type:

1. Select the required net.

2. Right-click the selected net and select the required type.
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. I NI [

- JP AlD Tree r
- dr a1l
- dr al2

5et as Power
Set as Ground
- dr Al3

P A4 Set as Signal
CJF a2 | [ Setas Undefined

i &

How to Find a Net

To find a specific net:

1. Click the Filtericon ( T ) next to Nets in the Parts tree.
2. Type the required net name.

3. Click H“’(‘* to display a list of matching algorithms, as shown in the following figure:

%l

r @ Simple

Regular Expression

Hierachical

© Simple: Display tree nodes that contains specified text
© Regular Expression: Display tree nodes that contains specified regular expression.

© Hierarchical: Display tree nodes that contains specified regular expression per hierarchy level separated by

slash.

Regular Expression is very powerful tool but it requires certain knowledge to use. Below is some

convenient example for typical use cases.

Example Match Note
u(1]2/511) Matches U1, U2, U5 and U11 "I" means "OR"
U[5-8] Matches U5, U6, U7 and U8 "-" can be used for "range"
U1[1-3] Matches U11, U12 and U13 U[11-13] doesn't work as
expected
DQ[1-8]N? Matches DQ1, DQ1N, D@2, "?" can be used as optional
DQ2N,...,DQ8 and DQ8N string

4. Select the string matching algorithm: Simple, Regular Expression, or Hierarchical.

The Hierarchical option is relevant when tree nodes are hierarchical
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How SIPro/PIPro Identifies the Net Type

SIPro/PIPro attempts to identify the net type by case-insensitive name matching. In case no match is found, the net type

is ‘Undefinded’. The algorithm uses following rules by default:

Type

Power

Ground

Signal
Memory
Clock
Diff pair

HS Serial

Regular Expression

pwr|power|vdd|vcc|vreflvtt|bat

~N\+H\-]Ad+[p_\d+v
~N\+\-]2\d+v

~AN\+\-]?\d+

gnd|ground|grnd|vss

dq

a\d+
ba\d+
clocklclk
_pn]$
N\+\-1$

sig|tx|rx

This rule can be modified by user. See here for more detail.

Setting the Net Type Manually

Examples

AVDD, DVDD, VREF, VTT, VBAT

+1p2v, -1p2v, 1p2v, +1_2v, -1_2v,
1 2v

+12v -12v 12v

+12,-12,12

AGND, AVSS

DQO, DQ1

AO1, A2

BAO1, BAO2

CLK

DQSO_P, DQSO_N
DQS0+, DQSO-

SIGO1

To override the automatic net type, you can select one or more nets, right-click and choose the appropriate net type.

Components

All component instances in the layout view are listed and grouped per component.

How to Find a Component Instance

To find a specific component instance:

1. Click the Filtericon ( T ) next to Components in the Parts tree.

2. Type the component instance name.

3. Click Q"c‘ to display a list of matching algorithms, as shown in the following figure:

33



SIPro and PIPro

%l

r @) Simple
Regular Expression

Hierachical

4. Select the string matching algorithm: Simple, Regular Expression, or Hierarchical.

Substrate

The Substrate tree item presents the objects in the layer grouped by Conductor layer, Via layer or Dielectric layer.

How to View the Geometry by Layer

First, switch off the Parts Visibility toggle. This toggle can be found on the Geometry Window’s View toolbar. Then, select

the appropriate layer in the Substrate tree. The view displays the objects on the selected layer only.

Pins

All top level pins in the layout are listed.

Definitions

The Definitions branch stores definitions that can be applied to or shared with other objects within the project. You can
apply a definition to other objects in the Project panel by clicking and dragging the definition object on the required

object.

Materials

To view a material definition object, select a material from the Materials list.
4 | || Definitions
a M paterials

[ JAR

[ poLvimIDE

[ Fr4

[ ] copper

Scripts
The Scripts branch stores user-defined scripts. Right-click Scripts to add a new script or import an existing macro or

function script to the project.

You can execute or edit the script in the Scripting workspace window.

To add a new scripts:

1. Right-click Scripts in the Project panel:

- m *  Mew Python Script

.| Graphs :
™  Import Scripts...

2. Select New Python Script to create a new script or click Import Scripts to use an existing script.
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Analyses

The Analyses branch enables you to run a PI DC analysis, Pl AC analysis, PPR analysis, and Sl analysis. By default, it

provides an empty template for creating an analysis, as shown in the following figure:

ol | Analyses |

IE Analysis 1
- VEMs
& Sinks
dr Mets
_.": Component Models

“4. Options...
&% Run
7 Results
» Analysis 2
» Analysis 3
> Analysis 4

Instead of using the default templates, if you want to add a new analysis:

1. Right-click Analyses in the Project panel:

SIPro/PIPro Setup B X

P T Avaiyses '

. [52] Analy == New PI-DC Analysis

: Analy == MNew PI-AC Analysis

: Analy == Mew Power Plane Resonance Analysis
i Analy =4  MNew Power Aware S Analysis

¥ Scripts
7 Graphs | [ Delete Al

Tree »

2. Select the required analysis. A new analysis is added at the end of the Analysis branch.

Viewing and Hiding Project Tree Components

You can view or hide options present in the Project panel by using toggle buttons. The following figure displays these

toggle buttons:
plo==
The following table describes each toggle button:

Option Icon Description

View Parts @] Enables you to view or hide Parts in

the project panel.

View Definitions [I Enables you to view or hide

Definitions in the project panel.
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Option Icon
View Scripts

[ o
Toggle All -

Customizing View

To set a specific view for your design in the layout window, you can right-click the

the following options:

Option Icon
L =

Set Visible

. @&

Set Invisible

Solid -
o}

Wireframe o

Delete M

Expand

Workspace Windows

The SIPro/PIPro Setup window consists of the following windows:
® layout
® Simulation
® Parameters

® Scripting

Description

Enables you to view or hide Scripts in

the project panel.

Enables you to view or hide all the

components of the project panel.

required component and select one of

Description

Enables you to view the selected

component in the Layout window.

Enables you to hide the selected

component in the Layout window.

Enables you to display components in

a solid view in the Layout window.

Enables you to view or hide all the

components of the project panel.

Enables you to delete a component.

Enables you to display all the
subparts of a component in the

project panel.
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Layout Window

The Layout window provides a layout view of your design. In this window, you can use various tools for customizing the

view of a simulation space. This window comprises the main design viewing area.

The following table describes options available in the View menu and View Tools toolbar:

Option Icon Description
Toolbars ® View Tools
View Manipulation WS ® Select: The Select tool is used to

select objects as well as
manipulate the view of the

simulation space.

® Orbit: The Orbit tool is selected to
perform rotation of the simulation
space through left-clicking-and-
dragging.

® Pan: The Pan tool is selected to
perform translation of the
simulation space through right-

clicking-and-dragging.

® Zoom: Zoom-in or zoom-out of
simulation space by scrolling up or
down the mouse wheel,

respectively.

® Zoom to Window: Zoom into a
rectangular shaped area of the
geometry as specified by the user.
To use, select the tool, then left-
click and drag the mouse to

designate the rectangular zoom

area.
Zoom to Extents ¢ Enable you to zoom automatically as
can view the entire geometry.
- g ]
Zoom to Selection \ Enables you to automatically zoom
selected object only.
Standard Views The Standard View button function is

to automatically change the
perspective of the objects in the

workspace window.
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Option

Isometric Views

Custom Views

Cutting Planes

Field Reader

Icon

{;.’

=

Description

* Front (-Y)
* Back (+Y)
* Top (-2)

* Bottom (+2)
* Right (-X)

® Left (+X)

The Isometric Views button function
is to automatically change the
perspective of the objects in the

workspace window.

® Front/Right/Top

® Front/Left/Top

® Front/Right/Bottom
® Front/Left/Bottom
® Back/Right/Top

® Back/Left/Top

® Back/Right/Bottom

® Back/Left/Bottom

Enable you to define any perspective
than the Standard Views and
Isometric Views, and display at that

perspective.

® Add View

Cutting Planes button feature allows
you to define an arbitrary cross-

section of the object and display it.
® Toggle Cutting Plane
® Edit Cutting Plane

® Save Cutting Plane

The Field Reader tool measures field
values at the location where the

mouse hovers over the geometry.
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Option Icon Description

Export Image = The Export Image tool takes a screen
shot of the geometry as it is currently
shown in the workspace window, and

saves it to a specified location.

Toggle Parts Visibility [E]IEI Toggles the design parts on and off.
Clicking the Opacity button located
to the right of this button, opens a
slider to customize the translucency
of its objects. The sliders change the
alpha of the design objects, making
them more or less translucent as the
slider is dragged right or left,

respectively.

Toggle Output Visibility [Blﬁl Toggles the output results on and off.
Clicking the Opacity button located
to the right of this button, opens a
slider to customize the translucency
of its objects. The sliders change the
alpha of the design objects, making
them more or less translucent as the
slider is dragged right or left,

respectively.

Toggle Bounding Box Visibility 13 Ttoggles the visibility of the bounding
box of a design when the design is
selected.

Toggle Output Viewing Controls * Toggles the visibility of the output

viewing controls for sensor results.

Simulation Window

The Simulations workspace provides an interface to define simulations to send to the calculation engine. Simulations can
be easily created, defined, and stored in the Simulations workspace window. Each time a project is modified and saved,

you must define a new simulation to register the change. This workspace window stores definitions such as source types,
parameter sweeps, S-Parameters, frequencies of interest, scattered/total field interfaces and termination criteria that are

specific to a calculation. EMPro supports the following solver EM simulation technologies:

The following table lists the icons present in the Simulations window:
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Option

Simulation

Add To Queue

Remove From Queue

Delete From Queue

To start the next phase

Kill the Queue

Icon

Description

Starts a simulation.

Selects the required simulation from
the upper panel of the Simulations

window and add to the queue.

Selects the required simulation from
the upper panel of the Simulations

window and remove from the queue.

Deletes the selected simulation from
the disk.

To interrupt the current phase of the

simulation and start the next phase.

Kills the currently executed

simulation.

The following information is available in the upper pane of the Simulations window:

Option

Name

Date Created

Engine

Status

Description

Displays a project ID, which references the location of the

loaded project in the file directory.

Displays the project name specified by a user.

Specifies the date when a simulation was created.

The simulator used for performing simulation.

Displays whether a result is complete or still being

calculated while the simulation is running. This status can

be refreshed manually by pressing the Update button or

automatically by selecting Auto-scroll.

The following tabs are available in the lower pane of the Simulations window:
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Option

Summary

Notes

Log

Description
Provides a summary of the simulation such as simulation
path, status, boundary conditions, ports, feed, and

waveforms.

Displays any notes that you might have added while

setting up a simulation.

Displays a log of tasks performed during the simulation.

Scripting Window
The Scripting workspace allows you to view, edit, and execute scripts.

To create a new python script;

1. Select Script > New Python Script, as shown in the following figures:

Edit Execute View Editor

% Mew Python Script Ctrl+M
t:f Commit Ctrl+5
S Revert
=] Clear Qutput

2. Type commands in the scripting window:

i

© Scripting
Script Edit  Execute View  Editor
. W T - =
*EBE®»O0E:0C (PlE:
MNewPythonScriptd.py * | o
1 “This script demonstrates how
2 to use commandline;
[ P
>
(<type "exceptions.IndexError'>, IndexError('list assignment index out
of range',), <traceback ckject at 0x00000000154ECZ08>)

Scripting Options

The following table describes options available in the Scripting window toolbar:
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Option Description

Script ® New Python Script
® Commit
® Revert

® Clear Output
Edit Enables you to copy, cut, or select text in a script.

Execute ® Execute Script

® Cancel Execution

View ® Script Tools
® Editing Tools

® Execution Tools

Editor ®* View
® |ndentation
® ConvertEOL

® PsychicPy

Parameter Window

The Parameters window enables you to create, edit, and delete parameters that are referenced. By default, three

parameters are provided minFreq, maxFreq, and timestep.

i =

'i@' Parameters E@

Name Fermula Value Description
@ minFreq 100 kHz 100000 Hz Minirnum frequency of interest for ...
@' maxFreq 1 GHz 1000000000 Hz  Maximurn frequency of interest for...
ii timestep 5.66752e-11 566751634761, Simulation timestep in seconds

Revert Apply 9

To modify the frequency range of the default minimum and maximum frequency parameters:
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1. Click Parameters. The Parameters window is displayed.
Double-click the minFreq or maxFreq value in the Formula field.

Specify the required value.

Wb

Click Apply.

Parameter Options

The following table describes the Parameters options:

Name Description

Name Enables you to define a parameter, which can be

referenced later.

Formula Allows you to provide a mathematical formula or a simple
numeric value that will define the value of a given
parameter. This formula can reference other parameters

that have already been defined.

Value This column is a read-only column that displays the
evaluated value of the parameter. If an invalid formula is
entered, an error message will appear within this field
with a description of the invalidity. Simply hold the mouse
over the error message to view this description. Similarly,
a parameter is deleted by selecting the unwanted
parameter and clicking the button above the table. If a
parameter is deleted that is referenced within another
parameter's definition, an error message will appear since

the parameter that is referenced is no longer defined.

Description Allows you to describe a parameter.

Configuring SIPro and PIPro

Before setting up an SIPro/PIPro project, you can configure the project settings by using the Options window. This
window consists of various tabs such as General, Interface, Modeling, and Nets. Using these tabs, you can specify the

global settings for your project.

Select Tools> Options to open the Options window. In this window, you can use the following tabs:
® General
® Interface

® Modeling
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® Nets

General

The General tab enables you to set the following options:
® Templates: Enables you to specify the default folder location for storing SIPro/PIPro project templates.
® Rendering Options: Allows you to control several display options in the SIPro/PIPro GUI:

® Graphics Drivers: Specifies the display driver to be used for rendering graphics in SIPro/PIPro. The list of available
drivers depends on the operating system, graphics card, and on the usage of remote desktop. Using an
unsupported display driver may result in a blank Geometry Window. Any change to this setting will take effect
until you restart SIPro/PIPro. The display driver can also be changed using the --driver command line option when

starting SIPro/PIPro. Available graphics drivers are: OpenGL, OpenGL 2, DirectX 9, X11, MSW.

® Transparency Algorithm: Determines the way SIPro/PIPro renders the parts opacity of an object. You can select

the values:

© Z-sort Only Fast: This is the most efficient rendering option, but may contain artifacts

(small areas of inaccurate rendering).

© Z-sort Only Nice: This is a more accurate rendering option than Z-sort Only Fast, but runs slower. It will

have less artifacts.

© Depth Peeling: This option is more accurate than both Z-Sort algorithms. It's performance is dependent on

the graphics card, and may be significantly slower if the card does not support it.
© Painters Algorithm: This is the most accurate rendering option, but runs the slowest. On modern graphics

cards, this option works very well.

Transparency Algorithm: This setting affects only the way an object is displayed in

the SIPro/PIPro interface, and does not affect calculation results.
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SIPro/PIPro Setup - Options [

General | Interface Modeling | Mets |

Templates Rendering Options

IUser Template Folder: Default Graphics Driver: [DpenGL - ]

al\Documents Keysight\ EMPro templates Transparency Algorithm: [Depth Peeling Fast "]
Text Color:

Ok ] [ Cancel Apply 9

Interface Tab

The Interface tab enables you to set the following options:

® Object Editing: Controls the editing of objects, when a new object is added to the project tree by right-clicking the

project tree. You can select one of the following values from the New Item Action drop-down list:
© None: Adds a new object to the project tree.

© Edit Name: Adds an object to the tree and provides a blinking cursor to add the object name in the project

tree.

© Edit Properties: Adds an object and displays the appropriate window to edit the new object properties. The
Material Editor dialog box is displayed to specify settings.

® Layout: Enables you to set preferences for saving or restoring the GUI layout.

® Information: Enables you to to set their preference for decimal precision in tooltips.

® Gridding: Enables or disables the use of the simplified grid.

® Project Tree: The /con/Text Size scroll adjusts the size of the items in the project tree.
® Workspace:

© Show All Tabs shows all workspace windows in tabbed workspace regardless of whether they are active or

not.
© Show Only Active Tabs stores only the active tabs that are stored in the project workspace.

© Don't Show Tabs removes the tabbed workspace. Windows can still be accessed from the View menu.
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® Appearance: The Appearance pane allows you to change the appearance of the SIPro/PIPro GUI and buttons

within.

-

SIPro/PIPro Setup - Options

(S5

interace

Modeling Nets

Object Editing

New Item Action: |Edit Name

D Open Properties in New
Window When Possible

Layout

Layout information is automatically stored
when 5IPro/PIPro Setup exits, The checkbox and button
below allow you to dear this information,

[ Clear Saved Layout on Restart (once)

’ Clear Saved Layout Mow

Information

H Show Full Predsion of Value for
Expressions' Tooltips

[] show Full Precision of Dimensions of Bounding Boxes
Gridding

Use Simplified Grid Specification
v
When Possible

Project Tree
Icon/Text Size
Workspace

@ Show All Tabs

() Shaow Only Active Tabs
() Don't Show Tabs

Appearance

7
7

Application Style: [System Default

Button Layout: [Default

Mote: Changes to style and/or button
layout take effect the next time SIPro/PIPro Setup is
started.

] [ Cancel Apply

0

Modeling Tab

The Modeling tab provides several options for adjusting the color and appearance of faces, edges, vertices, components,

and the background. You can set the default colors used to display faces, edges, and/or vertices for parts when they are

first created. You can also set the color of the components (like voltage sources) and Geometry window background

color.

® Components: Specifies the color used to render circuit components.

® Background: Specifies the background color of the View.

® Construction Grid: Specifies the color for the lines of the construction grid of the Sketcher and Orientation tools.

® Mesh Slice: The color for mesh edges that are Free Space.

® Invert Mouse Wheel: Switches the zoom direction when rolling the mouse wheel.

® Separate View Tools: Toggles between showing all View tools in a drop-down list or as individual items.

® Smooth View Transitions: Specifies SIPro/PIPro to perform smooth rotations between different view orientations. If

you do not select this option, SIPro/PIPro snaps to the selected view orientation.
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-
SIPro/PIPro Setup - Options

| General | Interface | Modeling | Mets |

View Options

Components:

Background: B

Construction
Grid: D

Mesh Slice
(Free Space):
[] render Sky:

Invert Mouse
a Wheel

Separate View
0 Tools

Smooth View
D Transitions

J [ Cancel

Apply

0

Nets

Using the Nets tab, you can specify the net type recognition rules for ground, power, and signal by using Regular

Expression options.

SIPro/PIPro Setup - Options

|Genera| I Interface I Made ling | Mets |

Met Type Recoenition Rule

Met Type Rule can be specified by Reeular Expresszion
Ground

*gnd *| *ground #| ¥grnd *| #vss *

[ Gase Senzitive

Power

[[] Gase Sensitive

Signal

Fegig | dote x| s | g | (BB TP [a A [(cd+ <+ > 0] | o lock 2| el 2|+ _[M]$ > _[pPIS

[ Gase Senzitive

Specify Met Hame to test

Differential Pair Recognition Fule

Reset

Minus Net Name
[NNMM](¥d+)?3$
#3

Plus Met Mame
[pPI(¥d+)?3

1

[ CGase Sensitive

Specify Met Mame to Test! Specify Met Mame to Test2

wir | ¥powve ¥ #edd ¥ #vco ¥| Rvred ¥ #hat *| #ett *| wd [pPY Jed+ [vw] #|[pP mME+E-17d+ [p_138d+ )70V #id+ [ *

Reset

Reset

Remove

Reset

Loc Jf

Cancel

Apply

o
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Also, you can specify differential pair recognition by using pairs of Regular Expression for plus net and minus net.

Differential Pair recognition is currently used only for mixed mode of S-parameter plots and TDT/TDR plot window.

Specify regular expression for Plus Net and Minus Net respectively. If given any of two Net names are matched with given
regular expressions and rest string that are matched pieces are stripped off are the same, they are recognized as

differential pair.
For example, regular expression P$ for Plus and N$ detect Sig1P and Sig1N as differential pair.

Either one of Plus or Minus can be empty. This can be used to recognize a case such as pair name is like AAA and AAA#. (

empty regular expression for Plus Net and #$ for Minus Net).

Add-on Manager

You can extend the SIPro/PIPro user interface with additional functions, which are customized for your design needs.

These tools are python scripts that you can customize for your workflow. You can access the following add-on tools:

® Component Models Add-on: Enables you to Export their Components and ComponetModels to a file and also

allows to Import them.

® Introspection Add-on: Enables you to generate the recipie of the setup and the elements of the setup like Sinks,

Vrms, Component Models and Results.

® Layers Display Setting: Enables you to change the Display Settings of the Conductive layers and the via layers in

the Active Project.

® ScaleViewZ Add-on: Enables you to add a toolbar to the main window to scale the view in the Z direction.

Add-on Manager

The Add-on Manager allows you to enable or disable add-ons, inspect their status and possible load errors, and modify

the search path. It can be accessed from Tools > Add-on Manager.
The Add-on Manager displays a separate panel with the following elements:

® A check box with the file name of the add-on: Select the check box to enable a add-on. Hovering over the file

name will show the full path of the add-on.

® The load status on the left of the check box: A green icon is shown when an add-on is successfully loaded, a
yellow exclamation mark when it failed to load. Hover over the icon to see the full error message. No icon will be

shown for a disabled add-on that is not loaded.

® If available, a short description of the add-on: Click in the Add-on Manager to display more information

about an add-on.

® |f available, two labels with the author and version information of the add-on.
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Keysight SIPro/PIPro - Add-on Manager l&]

L3

& ComponentModels.py

Component Models Add-on.

Author: Keysight Technologies, Inc.
Version: 1.0

& CreateScript.py

Introspection Add-on.

Author: Keysight Technologies, Inc.
Version: 1.0

m

& LayersDisplay.py

Layers Display Settings

Author: Keysight Technologies, Inc.
Version: 1.0 o

& ScaleViewZ.py
[ Add a toolbar to the main window to scale the view in the Z 57

Additional add-ons can be downloaded from the Knowledae Center and saved
on the search path:

C:Wsers'psinghal\Documents\Keysight\EMProtaddons

[ Ok ] [ Cancel

Add-on Search Path

You can download additional add-ons, which are saved on the following search path:

¢ Additional search path: A user specified location where downloaded or custom add-ons can be saved. This path
can be modified in the Add-on manager and multiple locations can be specified using the platform specific path
separator (colon on Linux, semicolon on Windows). By default, a location in the user home directory is set. Add-
ons discovered on the additional search path are disabled by default, and must explicitly be enabled in the Add-on

manager.

If multiple add-ons with the same filename are found, only the first one on the path will be loaded. This way, a default

add-on can be overridden by a custom version placed in the additional search path.

Installing Additional Add-ons

You can download more add-ons and updates from the add-on download page. To install an add-on, perform the

following steps:

1. Save the downloaded Python script to one of the locations configured in the additional search path.
2. Open the Add-on Manager.

3. Find the new add-on and select its check box to enable it.
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If the downloaded add-on is an update of the existing add-on, save the the update on the additional search path. Restart

ADS and the updated version should be found and loaded instead of the original.

Once an add-on is added, it cannot be unloaded until the program is exited. While managing add-ons during a session,

consider the following factors:

® When a loaded add-on is disabled, the status icon will still be shown in the Add-on Manager. Only the next time
that ADS is started, the add-on will no longer be loaded.

® When an add-on fails to load because of a Python exception or other error, it will remain in this state even if the

error is fixed. Restart ADS to load the add-on.

® When add-ons with the same file name are found on the search path, only the first to be found is loaded.

However, if the first add-on was added only to the path while ADS is already running, it does not overrule an add-

on by the same name that is already loaded, even if the latter one is found further on the search path.

Setup Options for Customizing Results

While viewing the results of an analysis, you can specify the setup options displayed in the following figure:

Setup

Auto-Apply !‘ Apply Rewvert

Range Autamatic

Min |0 &/ mm#ed
Max | 100618 & mme2

Size Factor: 100 = Scale Vectors

Layer [Show Al v]
Met Type [Power v]
Range

The following table describes the Range options:

Range

Min

Max

Layer

Net Type

Automatic

Description

Minimum value of the scale bar

Maximum value of the scale bar

Layer name to show the values

Net type to show the values (Not available in some type
of filed plots)

Automatically set the Min/Max values. Turn this option off

if you want to specify your preferred Min/Max.

For complex/multi-layered board, it might be difficult to display the Field plots for all layers. In such a scenario, using

Layer Display Settings add-on to limit the displaying layers as well as Layer selector and/or Net Type selector in the Field

plot setup provides a better view.
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Select the following options for a better view:

® From the Layer drop-down list, select Show All, from the Net Type drop-down list, select Power , and in the Layer

Display Settings panel, select All Layers Visible,

View

[VDD_GND_DCI: Voltage (V)

L —
119 1191 1192 1194 1195 1196 1197 1198 1199

N e AN 2 B LRl R 03 P ) BN

[VDD.GND_DGE Valtaee ~ | [HideOthera] [ Unload |
Setup | 1 Auto—rpoly Mg [ Apply | [ Revert |
Range Automatic
Min 04 | [ Default |

Max (11887 ¥ | [ Deteur |

Layer [Show All -

Laver Display Settings g X

&l Layers [i]

ETGH_SPLITS (1002) 1l
ETGH_SPLIT# (1003)
ETGH_S6 (1004) -
ETGH_WDDS (1005)
=@

ETCH_S7 (1006)
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® Layer: ETCH_SPLIT3, Layer Display Settings: ETCH_SPLIT3, Net Type: Power

I Layout [E=E (B8 ==
View
[VDD_GND_DC]: Voltage (V) [E_E]
S L e—
119 1191 1192 1194 1.195 1186 1.197 1198 1.199
3]
&
-
+ I
-
&~
b
Aa
(Al
&

[[VDD_GND_DC] Voltags ~ | [Hide.Gthers] [ Unicad ]
Ttup‘ [¥] Auto-Apply A Apply Revert
Ranee Automatic
Min [0 4
Max 110876
Layer
Laver Display Settings & X

Al Lavers Q
ETCH_SPLITS { 1002) 1

ETCH_SPLIT4 (1003)

m

ETCH_S6 (1004)

ETCH_WDDE (1008}

BEEE

ETCH_S? (1006}

Size Factor

Specify the size factor of the arrows in the window. ( Below left is Size Factor = 1, Below right is Size Factor = 2 )

Excitation: Specify a excitation source from either VRMs or Sinks you defined in the setup.(Not available in some type of
filed plots)
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Frequency: Specify a frequency to display values.(Not available in some type of filed plots)

Hiding and Unloading Results

While viewing results in the Layout window, you can hide and unload other results.
® To hide other results, click the Hide Others button.

® To unload other results, click the Unload button.

See Also

® Viewing PI-DC Analysis Results
® Viewing PI-AC Analysis Results
® Viewing PI-PPR Analysis Results

® Viewing Power Aware S| Analysis Results
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Using Component Models

Using Component Models

Contents

® Creating and Editing Component Models for Analysis

® Using Vendor Parts DB Browser

Creating and Editing Component Models for Analysis

For an SIPro/PIPro analysis, you need to calculate the impact of decoupling capacitors. Identify the component models

and define electrical models for the selected components by defining component models.

In this section, you will learn how to create component models and then add a lumped, SnP, or model DB for analysis.

Creating Component Models for Analysis

To create a component model for analysis:

1. Select a component group in the Components list.

2. Right-click the selected component group and select Create Component Model for Analysis. The SIPro/PIPro
Setup window is displayed.

» €] 240UNBUFDDR3_C...
4 |_l: CAP 2_2pF__ ZRHF
- > a3 = Tree k

- > ca g
> [ €] CAP_2 2uF_+_
> [6] CAP_1uF 20 | 4 Create Sinks for Analysis...

> &) CAP_22uF +_ E Create I/ 0 Ports for Analysis...
> | €| DDR3I_X16_FB( E Create Component Models for Analysis...

4 (€| Components T ‘H

Create VREMs for analysis...

3. Select the target analysis where you want to create the component model:
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r SIPro/PIPro Setup [""E—E"'J

Select a target analysis
[PI-DC] Analysis 1
[PI-AC] Analysis 2
[P&-51] Analysis 4

Ok ] [ Cancel

4. Click OK.

You can also drag and drop the selected components on Component Models in the SIPro/PIPro

Setup. The instances will be grouped by component name.

Editing a Component Model for Analysis

After creating a component model in the SIPro/PIPro Setup panel, you can define the electrical model parameters. The

following types of models can be added:
® Lumped
® SnP
® Model DB

® Multiple Model DBs

Adding a Lumped Model

To define a lumped component model:

1. Double-click the component group in the SIPro/PIPro Setup panel. The Component Model Editor is displayed.
2. Select Lumped from the Add drop-down list.
3. Specify the Resistance, Inductance, and Capacitance value.

4. Select an RLC arrangement option.
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P

Component Model Editor ( CAP_2 2pF_ 25pF_SMIC0402_511-50007... El@

Model List
Mame Type
model Lumped
Add V] [ Remove ] [ Set Default
Model

Resistance: 0 Ohm

o
Inductance: 0H
Capacitance: 0OF
@ All Series
RLC Arrangement: () Al Parallel
@ RLIIC o]

[ Done ][ Cancel ][ Apply ]

5. Click Apply.

6. Click Done.

Adding an SnP Model

You can add an SnP model for multi-port components, such as 4-pack resistors and 7-pack resistors. To define an SnP
component model:

1. Double-click the component group in the SIPro/PIPro Setup panel. The Component Model Editor is displayed.

2. Select SnP from the Add drop-down list.

3. Specify the S parameter file in the File Name text box. You can also click :] to browse to the required
file.
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Compeonent Model Editor { c_capacitors_0402-511-500043_1.0a ) EI@
Model List
Marme Type
model Lumped
Add 'l ’ Remove ] ’ Set Default
Model
Resistance: (0 Ohm [N
Inductance: 0H
Capacitance: 1uF
@ All Series -
RLC Arrangement: () All Parallel
JRL]IC —_—0
Reve Done ] [ Cancel Apply
4. Click Apply.
5. Click Done.

Selecting an Existing Model DB

To use an existing model:

1. Double-click the component group in the SIPro/PIPro Setup panel. The Component Model Editor is displayed.

2. Select Model DB from the Add drop-down list.

3. Click :] in the Model section.

4. The Model DB window is displayed.

5. Select the required model.
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I'I'[

-m 200V and over/ under Japanese Law | GA242QR7TE2102MWO1 -I

-
Model DB =i [z
- -
Id Vendor Family Part Mumber Part Series Part Type B
Filter |Fi|tE|‘ |Fi|ter |Fi|tE|‘ |Fi|ter | Filter |
Murata 200V and over/ under Japanese Law GA242QRTE24TIMWOL GA242

- g @ Q{ [:] / R q_ Ao 4, FartDetais
o Q
S Impedance Vendor

Family

le404 Part Number
Part Series
Part Type
Topology

R

L

C

Tolerance

Impedance {ohm)

le403
Dimension

Temperature Characteristic
Cost

Rated Voltage

Start of Frequency Range

0.01 100 le+05

Frequency (MHz) EndofEzequency/Range

Murata

ind overf under Japanese Law
GAZ420QR7FE2102MWO1
GA242

C

Series

199,132 Ohm

919.687 pH

1inF

20 %

XTR

250V

100 kHz

3GHz

Ok ] [ Cancel

6. Click OK. All the fields are filled with the details of the selected model.

7. Click Apply.

8. Click Done.

Selecting Multiple Model DBs

To use an existing model:

1. Double-click the component group in the SIPro/PIPro Setup panel. The Component Model Editor is displayed.

2. Select Multiple Model DB from the Add drop-down list.

Click :] in the Model section.

The Model DB window is displayed.

oW

5. Select the required models.

6. Click OK. All the fields are filled with the details of the selected model.

58



SIPro and PIPro

Component Model Editor { CAP__22uF_+_-10__5MC0402_511-10204 )

&

fo e ]

Model List
Mame Type
model Model DB
model_2 Model DB
model_3 Model DB
model_4 Model DB

Add w7 ] [ Remove l [ Set Default
Model
GAZ430RTE2332MWO1
Part Details
Vendor Murata
Family ind overf under Japanese Law
Part Number GAZ430QRTEZIZ2MWO1
Part Series GAZ243
Part Type C
Topology Series
R 18.0515 Chm
L 757,585 pH

I

m

Done ][ Cancel ][

Apply

7. Click Apply.

8. Click Done.

Specifying a Default Model

If you have added multiple models, you can select a default model that will be considered during an analysis. After you

have completed a simulation, you can change the default model and view results immediately. You do not need to re-

simulate your design.

To specify a default model:

1. Double-click the component group in the SIPro/PIPro Setup panel. The Component Model Editor is displayed.

2. Select a model in the Model List section.

3. Click Set Default. For example, in the following figure, model_4 is selected:
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Compeonent Model Editor { c_capacitors_0402-511-500043_1.0a ) EI@
Model List
Marme Type
model 2 Lumped

model_3 SnP
model_4 Model DB
model Lumped

Add 'l | Remave | | Set Default

Model

Resistance: (0 Ohm

———
Inductance: 0H
Capacitance: 0OF
@ All Series
RLC Arrangement: All Parallel
RL|IC S —S

Revert Done ] | Cancel | | Apply

4. Click Apply.

5. Click Done.

Specifying a Model with more than 2 pins

If you have a component that has more than 2 pins, you can specify port numbers for each pins to define how the model

is connected when simulated.
If number of pins of component is more than 2 Ports pane appears in the left of the dialog.
To specify ports and models
1. Modify Port Number column so each pin connection matches the actual model's port numbers. "0" means
common reference ground. In below example, 3 ports are defined where P1( + ) and P4 ( - ) as Port1, P2( + ) and

P4( - ) as Port2, P3( + ) and P4( - ) as Port3. You can make Port Number column blank if you don't want to

connect model to that pin.

2. Specify model(s) that matches the number of ports you defined in Ports pane.
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Component Model Editor ( FourPin ) EI@

7] Arraved Component

Ports Model List
Name Type
Pin . Port Number ekl Sk
= P1 1
O P2 2
= P3 3
O P4 0
Add v] [ Remave ] ’ Set Default
Model

File Mame: :]

Dane H Cancel H Apply

Specifying a Arrayed Component

If you have an arrayed component contains multiple 2-pin components, you can define it by using "Arrayed Component"

checkbox.
To specify a Arrayed Component
1. Check Arrayed Component checkbox. Note that the checkbox only appears when the component has more than 2
pins.

2. Specify Port Numbers for each pins. Use "-" sign to make pin connects to minus terminal of the port. In below

example, P1 connects to plus terminal of port1 and P5 connects to minus terminal of the port1.

3. Specify 2-pin model(s). The same model will be applied to each ports.
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&

Portz

Compenent Medel Editor ( Rpackd )

Arrayed Component

Pin
Pl
On P2
On B3
On P4
Tn PS
n PE
On PY
n PE

Port Number
1

2
3
4

B R

[F=3 Eo8 5
Mode| List
Name Type
maodel Lumped
Add v] [ Remove ] [ Set Default
Mode|
Resistance: [ Ohm
Inductance: 0 H
Capacitance: [ F
@ Bl Series
RLG Arrangement: () All Parallel
(I RL||G -
Done ] [ Cancel ] [ Apply

Using Vendor Parts DB Browser

Using Vendor Parts DB Browser

SIPro/PIPro provides a database of vendor part electrical models. It provides a complete set of MuRata, Samsung, and

TDK components. You can select an electrical model for the required capacitor in the Vendor Parts DB Browser window.

To display the Vendor Parts DB Browser:

1. Select Tools > Vendor Parts DB. The Vendor Parts DB Browser window is displayed.

2. Select the required electrical model. You can also use the Filter text field to search the required model. Type a

value in the required column. You can use multiple filter values. For example, the following figure displays results

of the 2.2uF capacitors search.
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.. Vendor Component Browser =N E=E
[Add Component from ADS] [Add Custom Component. ] |Remnve Custom Cnmpnnent|
Part Series Part Type Model Type R Datasheet L Datasheet C Datasheet Topelogy R M(é

Filter Filter Filter Filter Filter 2 2 ufF Filter Filt

T A S N A T T

GCMI1E Lumped 2.2uF Series 8.07662

GCM21 C Lumped 2.2 uF Series 5.84739

GCM2 C Lumped 2.2 uF Series 5.84739
GCM21 C Lumped 2.2uf Series 584738 -

4 m 3

3

BRBEORE, RTP o » o 2

GCM1EERTO|225KE22 |iance User Defined Mo
Vendor Murata
100 Family Automotive
Part Number GCM18BR70]225KE22
Part Series GCM18 I
£ 10 Part T
_g a ype C
“; Model Type Lumped
o
S R Datasheet
Ee] 1
“é- L Datasheet P |
- C Datasheet 2.2uF
0.1 Topology Series
R Model 8.07662 mChm
L Model 553.175pH
0.01
0.01 100 le+05 C Model 1.38286 uF
Frequency (MHz) i
Tnlaranra An o

In the Vendor Parts DB Browser window, you can also view the impedance of various capacitors. You can select multiple

capacitors in the window and compare the impedance value, as shown in the following figure:

Vendor Component Browser |5 E

(®) Clear Filters Add Compenent from ADS. . ] [Add Custom Component.. ] |REmUvE Custom CDmpUnEntl
User Defined Vendor Family Part Number Part Series Part Type Model Type R Datasheet LDatasheet |~
Filter Filter Filter Filter Filter Filter Filter Filter Filter

_ 0V and over/ under Japanese Law | GAZ42QRTE2471MWOL | G,
_ 0V and over/ under Japanese Law | GAZ42QRTE210ZMWO1

_ 0V and over/ under Japanese Law | GA243QR7E2222MW01
0V and over/ under Japanese Law | GA243QRTE2332MW01
S —

e EOX PSS o Part Detais -

GA2420R7E2471MWOL Imp edance =iz -
GA2420RTE2102MWOL Vendor Murata
— — - GA2430RTE2222MWOL
— = GA2430RTE2332MW0L Family 200V and overf under Japanese Law
Part Number
le+03 Part Series L
— Part Type €
£
s Model Type Lumped
100
g R Datasheet
&
T L Datasheet
o
E 10 CDatasheet L
Topology Series
1 R Model
L Model
€ Model
0.01 01 1 10 100 1le+03 le+04 le+05 Tolerance 20 %
Freguency (MHz) -

The properties that are the same for all selected components appear grayed out in the Part Details panel.

Adding Components to the Vendor Parts DB

SIPro/PIPro allows you to extend the existing vendor parts database. The following types of models are supported:
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® Component from ADS
® Lumped

® SnP

Adding Custom Component

Adding a Lumped Model

To add a custom lumped model type to the Vendor Parts DB:
1. Click the Add Custom Component button in the Vendor Components Browser window to open the Component
Model Creator dialog box.
2. Select the Lumped model type from the Select Model Type drop-down list.

3. Specify the Lumped Model properties:

Component Model Creator EI@
M PartNumber:  Custom Capacitor 0001 Select Model Type: |Lumped ~
Viendor [ Family [ Part Series
Vendor: PC3-10600-UDIMM-V0_50_RC_Fx_20070530_lib_0
Family: PC3-10600-UDIMM-V0_50_RC_Fx_20070530_adfi

Part Series: KEY23

RLC Arrangement Model Valugs

@) all Series Resistance: (0,45 chm
All Parallel Inductance: 9 43=-10H
RL|IC

Capacitance: 4 32e-10F
Datasheet Values
L Resistance: 50 ohm

Inductance: O0OH

LN, Cepeciance: oF

Revert Done ]| Cancel || Apply

4. Click Apply.

5. Click Done.

Adding an SnP Model

To add a custom SnP model type to the Vendor Parts DB:

1. Click the "Add Custom Component..." button in the Vendor Components Browser window to open the Component
Model Creator dialog.

2. Select the SnP model type from the Select Model Type drop-down list.
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3. Specify the S parameter file in the File Name text box. You can also click E to browse to the required file. The

pin-port configuration is automatically generated from the S parameter file.

s

i Parthumber:  Custom Capacitor 0001 Select Model Type:
Vendor [ Family [ Part Series

Vendor: PC3-10600-UDIMM-V0_50_RC_Fx_20070530_lib_0

Family: PC3-10600-UDIMM-V0_50_RC_Fx_20070530_adf

Part Series: KEY23

Fin+Port Configuration
Number of Ports: 1 Number of Pins: 2

Pin-Port Mapping: {F1%"1", "Pref": 0%

Component Model Creator EI@

SMP

File Name: C:/Users/samdauwe fvendorpartsdb KEY 23.3np

Done ][ Cancel H

Apply

4. Click Apply.

5. Click Done.
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PIPro Analysis

PIPro Analysis

Contents

® Tutorial-Performing a PI-DC and PI-AC Analysis
® PIPro Analysis Setup Overview

® PI-DC Static IR Drop Analysis

® PI-AC Dynamic IR Drop Analysis

® PI-PPR Analysis

Tutorial-Performing a PI-DC and PI-AC Analysis

In this tutorial, you will learn how to create a PI-DC and PI-AC analysis setup, run the analysis, and view results. The

example workspace contains a Samsung DDR4 UDIMM memory card. The design files are downloaded from JEDEC (www.

jedec.com) and used for demonstration purposes. The example design consists of a 6 layer board with a single power rail

for core and I/0 buffers, as shown in the following figure:

o i

You can view the nets, components instances, and individual nets in the navigator window. The main power net passes
from the conductor at the bottom of the design to the devices at the top. GND nets are present on the design. The
substrate pack consists of routing on the top and bottom layer. The power and GND nets are on layer 3 and 4. Before

performing the PIPro analysis, you need to know the names of the power and GND nets.

In this example design, the VRM is connector J1, which is the source of power supply. It is the connector device at the
bottom of DDR4 board. There are eight sinks, which are the ICs distributed over the board. The power supply is

consumed by sinks. You will analyze the impact of decoupling capacitors.
You can access the example workspace from the following location:
examples/HSD/SIPro_PIPro_Getting_Started_Example_wrk.7zadsfcv
In this tutorial, you will perform the following tasks:

® Perform a PI-DC analysis

® Perform a PI-AC analysis
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Performing a PI-DC Analysis

You can analyze the voltage drop in the VDD-GND power distribution network. The supply power comes in through

connector 'J1', the ICs that consume current are the 'DDRA4...' component instances. There are no series components.

To perform an analysis, open the SIPro/PIPro Setup window:

1. Open a Layout window in ADS.

2. Select Tools > SIPro/PIPro > Open Setup from a Layout window to create a new or open an existing setup. The

SIPro/PIPro Setup window is displayed.

Creating a PI-DC Analysis Setup

To create a PIPro Static IR Drop (PI-DC) analysis, use the default empty template available in the project panel. Expand
DC Analysis 1 in the SIPro/PIPro panel, as shown in the following figure:

4 [Z Analyses
TMES| Analysis 1 |
- VRMs
& Sinks

_;': Compenent Maodels

. Options...
% Run
» T Results

To create a setup, you need to define the following:
* VRM
® Sink

® Options

Defining a VRM

To setup a VRM:

1. Select the J1 connector component instance in the Components list, as shown in the following figure:

4 w Design
4 PC4-RDIMM_V0S0_RC_FO_20131106_lib:PC4-RDIM...
o P Nets T

4 |[e Components | ® 11
PN A i 288dimmddrd_edge_conn-base
s> n

- [€] u_ddrd_d_fbga78-10x13_

2. Drag and drop the selected instance on the VRMs part in the SIPro/PIPro Setup panel. The Select Net for J1

window is displayed.
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Select Met for J1

Met Mame
VoD
YDDSPD
VREFCA
VREFDQ

e B e
PFins are connected to multiple Power nets. Please select a net to connect,
Pin Mames
1119711194 11191 11189 11186 J1.183 1.182..
11.236
11457
ni1

CK ] [ Cancel

3. Select VDD.

4. Click OK. A new VRM definition is added in the SIPro/PIPro Setup panel.

5. Double click the VRM definition to open the VRM Editor dialog box.

VRM Editor o[- ]
R L
PR !—,e_':'.’_‘-.-’“‘(
DC Voltage: 1.5Y M
Voltage Tolerance: 0 % +
Resistance: 0 Ohm — V DC
Inductance: 0mH — N
Reve Done ] [ Cancel Apply

6. Specify the DC Voltage, Voltage Tolerance, Resistance and Inductance.

Defining a Sink

Sinks are devices that consume current. To define a sink:

1. Select u_ddr4_x4_fbga78-10x13 at component level in the Components list, as shown in the following figure:
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4 [€ u_ddrd_d_fbga78-10:3_
> um
w2
>3
|
- > us
- {> us
w7
> us
- {> U9
i
> 12

2. Drag and drop the component on Sinks. Since the component connects to multiple power nets, the Select Net for

U7 dialog box is displayed.

Select Met for U7 [ | =] ﬁJ
Fins are connected to multiple Power nets. Please select a net to connect,
Met Mame Pin Mames
VDD U7.R9 U7.R1 U7.MN9 U7 N1 UT.KE UT.EK2 U7.HI UT.H2 UT...
VREFCA U7.M8
VREFDQ U7.HL
[ Use same selection for All Sinks/VRMs [ oK J [ Cancel

3. Select VDD as the power net you want to analyze.
4. Select the Use same selection for All Sinks/VRMs option.

5. Click OK. A Sinks definition is added having a list of 8 sinks, as shown in the following figure:
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4 E Analyses
4 [oc] VDD_GND_DC
4 = yRMs
. == vpD_11
4 & Sinks
VDD_UL
VDD_U2
VDD_U3
VDD_U4
VDD_US
VDD_U6
VDD_UT
VDD_U8
VDD_U3
VDD_UL1
VDD_U12
VDD_U13
VDD _U14
VDD_U15

e 5 S ST S e e e SR ST S e D e

6. Double click sink_U4 in the Sinks list to open the Sink Editor dialog box.

7. Type 30 in the DC Current field.

Voltage Tolerance: 5 3;:

Sink Editor [= ) 5 =)
DC Current: 30 A
Resistance: 1 MOhm # ) I_DC

Rewvert Daone

]| Cancel || Apply

8. Click Done.

Defining Options

A PI-DC analysis provides the following options:

® Use Ideal Ground Approximation. When enabled, this option will treat all Ground nets as ideal shorts. The power

rail is often the dominant contributor to the voltage drop. This option provides you the capability to analyze this

dominant factor in less simulation time.

To specify options:

1. Double-click Options LS:‘ in the Analyses list. The Setup PI-DC Simulation window is displayed.

2. Select Use Ideal Ground Approximation.
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3. Select Custom target mesh size and specify the required value.

SIPro/PIPro Setup - Setup PI-DC Simulation

Resolution: 5um
Arc Resolution: &0 deg
Custom target mesh size: 100 um

[ Use Ideal Ground Approximation

4, Click Done.

Saving the Analysis Setup

After defining your analysis setup, select File > Save. Now, you are ready to perform the analysis.

Running the Analysis

Double-click Run ¥ to start the PI-DC analysis. The Simulations window is displayed and the PI-DC analysis is initiated.

(i) Simulations EI@

&%l @® e

Id | MName |  DateCreated |  Engine |  Host |  Status
000001  Analysis1 Thu Apr 30 10:07:13 2015 PI-DC Local Queue Completed
Summary Notes Log Auto-scroll Update | |Completed

Starting the PI-DC simalstion. -

Setting environment for using FEM engine ‘=|
setting EMPROHOME to C-“\Program Files‘\Keysight“\ADS2015_03\fem'2015._01\win3Z_&4'bin' ;
setting PYTHONHOME to C:i\Program Files\Eeysighth\ADSZ015 053\ fem\2015.01\win3Z_ &4‘bin'
setting HPEESOF DIR to C:\Program Files'Eeysight\RDSZ015_ 09\fem\2015.01\win32 &4\bin
Generating DC mesh
Building Model
Building Surface Mesh
Cenerating Soclver Files
GCenerated:

105054 mesh elements
Cutput written to C-\Users‘psinghal“S5IPro_PIProd wrkisimilation\PC3-10800-UDIMMY%FP%C *

4 | 1 3

Viewing Results

After the simulation is complete, the results are listed in the project panel. You can view the results by double-clicking

the required Results option:
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4 T Results

| Owerview
Voltage
@ Current Density

Power Loss Density

:'u'.II- Generate Test Bench...
v Generate Sub Circuit...

~

Overview

Clicking the Overview option opens a window with a table based overview of voltages and currents at Sinks, Pins, VRMs,

and Vias.

DC Results Overview =RAC X
Sinks | pins | VRMs | vias | Reports |
MName Source Current [A] VRM Voltage [V] Input Voltage [V] Resistance [Ohm] Tolerance Marg

1 vDD_UL 1 1.2 118841 0.002 3% 0.02
2 vDD.L2 1 1.2 1.18899 0.0017 3% 0.02
3 vDD_U3 1 12 1.19018 0.0013 3% 0.02
4  VDD_U4 1 1.2 119176 0.0011 3% 0.02
5  VDD_US 1 12 119321 0.0011 3% 0.02
6  VDD_Us 1 1.2 119352 0.001 3% 0.02
7 vDDU7 1 1.2 1.19205 0.0012 3% 0.02
8 VDD.U8 1 1.2 1.1909 0.0015 3% 0.02
9 vDD_U9 1 12 11903 0.0019 3% 0.03
10 VDD_U11 1 1.2 119031 0.0019 3% 0.02
11 vDD_U12 1 1.2 1.19092 0.0015 3% 0.02
12 VDD_U13 1 1.2 1.19209 0.0012 3% 0.02
13 VDD_U14 1 1.2 119357 0.001 3% 0.02
14 VDD_U15 1 1.2 119318 0.0011 3% 0.02
15 VDD_U16 1 12 11917 0.0011 3% 0.03
16 VDD_U17 1 1.2 1.19015 0.0013 3% 0.02
17 VDD_U18 1 1.2 1.18897 0.0017 3% 0.02
18 VDD_U19 1 1.2 1.18841 0.002 3% 0.02
4 n 3

Voltage

Clicking the Voltage option in the Results list loads the voltage plot in the Geometry window. This is a scalar plot. The

voltage is forced at 0 at the negative pins of the VRMs.

Current Density

Clicking the Current Density option in the Results list loads the current density plot in the Geometry window. This is a

vector plot. The color indicates the current density amplitude. The white arrow indicates the direction of the current. The

arrow size is not an indication for the current density amplitude.
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& Layout =N o=

View

Area Power Density:(W/mm*+2)
.7294e-27 0.048066 0.096131 0.1442 0.15226

| [Analysis 1]: Power Loss Density hd | [ Hide Others | [ Unload |
Setup V| Auto-Apply & Apply Revert
@ Automatic Custom | Update ScaleBar
Range

Default Minimum | 4. 729382-27 W fmm*=2
Default Maximum | 0.152263 W /mm™*2

Layer | Showe All - |

Net Type |Sh0w All - |

Power Loss Density

Clicking the Power Loss Density option in the Results list loads the power loss density. This is a scalar plot. This plot

shows the power loss per unit area.

Generate Schematic

Clicking the Generate Schematic option opens a Schematic window with the VRMs, Sinks, Component Models and an

SNP that points to the DC S-parameter model.

Performing a PI-AC Analysis

After running a PI-DC analysis, you can perform the PI-AC analysis. A PI-AC analysis enables you to calculate the
impedance of the power distribution networks from different sinks. It helps you to determine and minimize the
impedance between power and ground pins at various IC locations on the board. A PDN should have the lowest
impedance for achieving good power integrity. Therefore, you need to minimize the impedance between power and
ground pins, which will vary based on the location of capacitors and the type and value of capacitor. The goal of PI-AC

analysis is to provide low impedance to all sinks.

In this example, the impact of components placed between the capacitors is calculated. You will use component models

of the MuRata library.
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Enable MuRata Library

In this example, you will run simulations with MuRata library components. Download the MuRata library from the Web:
http://www.murata.com/en-global/tool/library/keysight3

Include the MuRata library in the current ADS workspace and enable this library in ADS.

Opening the Example Design

Open the SIPro_PIPro_Getting_Started_Example_wrk.7zadsfcv design. The Pl analysis setup data for a specific design is

stored in a cell view of the “SIPro/PIPro Setup”.

Double-click the sipiSetup view in the ADS Main window.

4 €| PC3-10600-UDIMM
layout
sipiSetup

The SIPro/PIPro Setup window is displayed.

Creating a PI-AC Analysis Setup

In this example, you will copy the PI-DC analysis setup. Therefore, you do not need to redefine the VRMs, which are the

connectors for supplying power, and sinks that consume the current.

1. Right-click the PI-DC analysis setup in the project panel:

2. Select Copy > To PI-AC Analysis:

SIPro/PIPro Setup 8 x
4 [ Analyses |
3| vDD_GND_D
» [#£] VDD_GND_AC Highlight All
> [51] DQ_GND_J1| @ Run
* Scripts
£l Graphs + Copy. ¥ | o= ToDuplicate
[ Rename... ;2 | = ToPL-DC Analysis
Il Delete Del ==  ToPI-AC Analysis
==  To Power Plane Resonance Analysis
Order ' = To Power Aware Sl Analysis
Tree »
=4 Component Models 3
Create Script... 3

3. The PI-DC analysis setup is copied to create a new PI-AC Analysis.
4. Right-click the copied analysis and select Rename.

5. Type VDD_GND_AC, as shown in the following figure:
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4 VDD_GMD_AC
4 — VRMs
- & vDD_l1
& Sinks
-l Nets
N Component Models
“4. Options...
&% Run

Results

Defining a Component Model

For a PI-AC analysis, you need to calculate the impact of decoupling capacitors. Identify the component models and

define electrical models for the selected components.

To define a component model:

1. Select the component group c_capacitors_0603-511-500044_4.7a in the Components list. This group of

components will be analyzed.

2. Drag and drop the selected component on Component Models in the SIPro/PIPro Setup window. A new list is
created, as shown in the following figure:

4 €| ¢_capacitors_0603-511-500044 4,73
> a3
> e
> as
> s
> 8
>3
> 4
> 9
> cao
> 106
> cuz

After adding a component model in in the SIPro/PIPro setup panel, you may need to

delete the nets that are not connected to GND and VDD.

3. Double-click c_capacitors_0603-511-500044_4.7a in the Component Models branch to specify the electrical

models to be used for analysis.
4. Select Lumped from the Add drop-down list.

5. Type 4.7 uF in the Capacitance field.
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Component Model Editor ( c_capacitors_0603-511-500044_4.7a ) EI@
Model List
Name Type
model Lumped
Add '] ’ Remove ] [ Set Default
Model

Resistance: 0 Chm

—0
Inductance: 0H
Capacitance: 4,7uF &
@ All Series T
RLC Arrangement: () Al Parallel
@RLlC — o
Revert Done ] [ Cancel Apply

6. Click Done

You can also search an electrical model in the database provided by the vendor. For more
information, see Using Vendor Parts DB Browser and Creating and Editing Component Models

for Analysis.

Defining Options

To define options:
1. Double-click Options in the PI-AC Analysis list in the SIPro/PIPro Setup panel.
2. Accept the default Resolution and Arc Resolution value.

3. Click the Frequency Plans tab.

Type Start Stop Points Step
] Logarithmic 10 kHz 300 MHz 5/decade (24 points)
& Adaptive 10kHz 300 MHz 300 (max)
4. Click Done.
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Running the Analysis

Save your PI-AC analysis setup and double-click Run ¥ to start the PI-AC analysis. The Simulations window is displayed

and the PI-AC analysis is initiated.

Viewing PDN Impedance

To view PDN impedance results:

1. In the Results list, double-click PDN Impedance. The PDN impedance window is displayed.
2. Select the required sinks.

3. Right-click the selected sinks and choose Add PDN Impedance. The PDN Impedance plot is displayed.

PIPro Analysis Setup Overview

To perform a power integrity (PIPro) simulation, you require detailed information about the power distribution network
(PDN) in a design. This information includes identifying the voltage regulator module (VRM), the IC that consumes power,

the components and component models, and stimulus for the analysis.

Prerequisites

Before performing a PIPro analysis, you need to gather the following Information about a PDN:

¢ |dentify the power and ground rail net name(s) that you want to analyze and obtain the DC voltage. A power rail

can consist of multiple nets that are connected through series components.

¢ |dentify the instance name (or reference designator) of the Voltage Regulator Module (VRM). In case the VRM is
not mounted on the Printed Circuit Board (PCB) and the supply power comes in through one (or more) connectors,
identify these instances name(s). Also, the power rail and ground rail might come in through a separate connector.

For such designs, you need to identify both connector instance names.

® |dentify the instance name(s) of the ICs that consume power. Obtain the DC current consumption properties of
each IC. This is the total current that will be distributed among the set of individual pins of the IC. Obtain the
allowed DC voltage drop for each power rail. This is the recommended minimum DC supply voltage that is needed
by the IC to guarantee proper operation. You might consult the datasheet, ask the vendor, run the power

calculator provided by FPGA vendors, or ask the IC designers.

® |dentify the instance name(s) of all series components on the power rail. These are typically resistors, inductors, or

fuses. Obtain the electrical model parameters for them (RLC values and topology).

Setup

In a new SIPro/PIPro setup, you can use the empty templates for PI-DC, PI-AC, and PPR analysis in the Project panel. You
can also create a new analysis. To create a new analysis, right-click Analyses and choose the required analysis. The

following figure displays the PI-DC and PI-AC setup:
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A Anaiyses
4 [oc] VDD_GND_DC
-+ VEMs
& Sinks
-l Nets
Ny Component Models
<. Options...
&% Run
= Results
4 VDD_GMD_AC
-+ VEMs
& Sinks
-l Nets
Ny Component Models
<. Options...
&% Run
= Results

VRMs

A voltage regulator module (VRM) allows processors with different supply voltage to be mounted on the same

motherboard. A VRM regulates the voltage fed to a microprocessor. While creating an analysis setup, you can define

various properties of a VRM, such as the DC voltage, voltage tolerance, and resistance.

Sinks

A sink is a component, such as ICs, that consumes electricity in a design. While creating a setup, you can define the

amount of current the ICs will consume by defining the properties of a sink, such as the DC current, resistance, and

voltage tolerance.

Options

The following table describes various options available for a PIPro analysis:

Option

Resolution

Arc Resolution

Custom Target Mesh Size

Use Ideal Ground Approximation

Description

This option specifies that points closer than the
Resolution distance will be considered as equal during

simulation

Arc resolution is used to discretize arcs and circles during

simulation

Specifies the mesh size for generating the global 3D

mesh during simulation

Ground net metalization is modeled as a perfect

conductor during simulation
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PI-DC Static IR Drop Analysis

PI-DC Static IR Drop Analysis

® Creating a PI-DC Analysis Setup

® Viewing PI-DC Analysis Results

Creating a PI-DC Analysis Set up

Using SIPro/PIPro, you can perform a PI-DC analysis to compute the voltage, IR drop (voltage drop), current, and power

loss density in the power supply nets. The DC analysis helps you to identify the IC and connector pins or stitching vias

drawing large amounts of current at DC.

Due to excessive voltage drop, the power supply voltage at the IC might fall below the recommended minimum voltage.

This can cause malfunctioning of the IC. Excessive current density in the perforated power supply rails can generate

excessive heat, which might lead to board failures due to de-lamination or fusing. Also, excessive current in the stitching

vias can lead to via failures losing connection. Any number of power supply nets with source and sink models can be

simulated together.

You can use the default empty template available in the project panel. Expand the DC Analysis 1 option present in the

Analyses node:

4 [[= Analyses
Sl Analysis 1|
- WRMs
& Sinks
..": Component Models

. Options...
4% Run

» T Results

You can also create a new analysis. To create a new analysis:

1. Right-click Analyses and select New PI-DC Analysis.

« BT u

: I?_;I Analy == New PI-DC Analysis

, Analy == New PI-AC Analysis

> Analy of=  Mew Power Plane Resonance Analysis
> Analy ==  MNew Power Aware SI Analysis

;'E. Scripts I Rename...

= Graphs Tree

2. Expand the analysis tree node of the new analysis branch:

F2
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2 Anaiyses
» El Analysis 1
: Analysis 2
» Analysis 3
> El Analysis 4
4 El Analysis 5
- VRMs
& Sinks

N Component Models

“4. Options...
&% Run

» 70 Results

Defining a VRM

A VRM regulates the voltage provided to a microprocessor.
To define a VRM:
1. Select a VRM (or connector) component instance in the Parts tree. You can also search the required component.
For more information about, see How to Find a Component Instance.

2. Drag and drop the selected instance on the VRMs part in the project panel. A new VRM definition is added in the

project panel.

4 El Analysis 1

4 — VEMs
o wrm_l

> & Sinks

9 Compeonent Models

"’1’\ Options...
% Run
» 7 Results

3. If the VRM connects to multiple power nets, the Select Net for Instance dialog box is displayed, where you have

to select the required net. The same applies for ground nets.

4. Double click the VRM definition to open the VRM Editor dialog box.

5. Specify the DC Voltage, Voltage Tolerance, and Resistance. The Inductance will not play a role for a DC analysis.

The Voltage Tolerance (absolute or in percent) is the voltage drop that is allowed at the output pins of the VRM.

There will be no voltage drop in the VRM in case the series resistance and inductance values are 0.

6. Click Done.

Defining a Sink
A sink is a component that reduces the temperature of an electronic device by dissipating heat into the surrounding air.

You can define the following options for a sink:

To define a sink:

1. Find the IC component instance(s) in the Components list.

2. Select the instance(s) and drag and drop them onto Sinks. New Sink definitions will be added in the tree.
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3. In case the IC connects to multiple power nets, the Select Net for Instance dialog box is displayed, where you can

select the required net.

4. In case multiple instances were dropped, the Select Net for Multiple Instances dialog box provides a check box to

Use same Selection for All Sinks/VRMs. The same applies for ground nets.
5. Double-click the Sink definition to open the Sink Editor dialog box.

6. Specify the DC Current, Resistance and Voltage Tolerance. The Voltage Tolerance (absolute or in percent) is

maximum voltage drop that is allowed at the input pins of the IC.

Defining Options

A PI-DC analysis provides following options:

Option Description

Use Ideal Ground Approximation When enabled, this option will treat all Ground nets as
ideal shorts. The power rail is often the dominant
contributor to the voltage drop. This option provides you
the capability to analyze this dominant factor in less

simulation time.

Running the PI-DC Analysis

After saving your analysis setup, double click Run to start the PI-DC analysis. The Simulations window is displayed and

the PI-DC analysis will start. The Simulations window allows you to monitor and manage simulations.

Show Me How Do | Perform a PI-DC Analysis

Video: How to Perform a PI-DC Analysis

Viewing PI-DC Analysis Results

After completing a PI-DC analysis setup, you can run the analysis in SIPro/PIPro. You can view the overview, voltage,

current density, and power loss density. You can also generate a schematic.

Running a PI-DC Analysis

To run a PI-DC analysis and view results:

1. Save your PI-DC analysis setup.

2. Double-click Run to start the PI-DC analysis. The Simulations window is displayed, which allows you to monitor

and manage simulations. The results are listed in the project panel.

3. Expand Results in the Analysis list of the project panel:
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4 T Results
- Owerview
Voltage

@ Current Density
@ Power Loss Density

:{EI- Generate Schematic...

4. Double-click the required analysis result.

Overview

Clicking the Overview option in the Results list opens the DC Results Overview window. This window provides a table-

based overview of voltages and currents at Sinks, Pins, VRMs, and Vias.

Sinks

In the Sinks tab, you can view the source current, VRM voltage, input voltage, resistance, tolerance, and margin values.

DC Results Overview l =NEEl X ]

Sinks | pins | vAMs | vias | Reports |

Mame Source Current [A] VRM Voltage [V] Input Voltage [V] Resistance [Ohm] Tolerance Marg
1 voD_U1 1 1.2 1.1835 0.0019 3% 0.04
2 VDD_U2 1 1.2 1.19003 0.0016 3% 0.02
3 VDD_U3 1 1.2 119114 0.0012 3% 0.02
4 VDD_U4 1 12 1.19258 0.001 3% 0.02
5 VDD_US 1 1.2 11933 0.0011 3% 0.02
6 VDD_U6 1 1.2 1.19417 0.001 3% 0.03
7 voD_U7 1 1.2 1.19285 0.0011 3% 0.02
8 VDD_Ug 1 1.2 119178 0.0014 3% 0.02
9 VDD_Ug 1 1.2 119122 0.0018 3% 0.02
10 vDD_u11 1 1.2 119123 0.0018 3% 0.02
11 vDD_uiz 1 1.2 11918 0.0014 3% 0.02
12 vDD_U13 1 1.2 1.1929 0.0011 3% 0.02
13 vDD_U14 1 1.2 119422 0.001 3% 0.03
14 VDD_U15 1 1.2 119377 0.0011 3% 0.02
15 VDD_Uls 1 1.2 119252 0.001 3% 0.02
16 VDD_U17 1 1.2 119111 0.0013 3% 0.02
17 vDD_U18 1 1.2 1.19001 0.0016 3% 0.02
18 vDD_U19 1 1.2 1.18949 0.0019 3% 0.02
“ 1 3

Pins

To view pins:

1. Click the Pins tab in the DC Results Overview window.

2. Choose the required pin from the Select Pins drop-down list. The table is updated with the selected pin results.
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DC Results Overview | o | & 23 |
| Sinks | Pins | VRMs | Vias | Reports
Select Pins: [U4 { PC4-RDIMM_Y090_RC_F0_20131106_lib:u_ddr4_x4_fbga78-10x13__) - I
Select Ping in Project Tree Digplay Resuilts in Layout
Mame Met Name Met Type Voltage [V] Current [A] ol
1 u4.p_al VDD Power 119415 0.569227
2 Ud.P_A2 GND Ground 0.00156432 -0.111885
3 U4.P_AB GND Ground 0.00156432 -0.176586
4 u4.p_s9 GND Ground 0.00156432 -0.194285
5 U4.p_B2 VDD Power 119415 0146461
6 U4.P_BS VoD Power 119415 -0,0463914
7 Hap wnn Dramer 110415 N 27N0NA =

VRMs

To view VRMs, click the VRMs tab in the DC Results Overview window.

Vias

To view ID and current of vias, click the Vias tab.

Reports
To generate a PI-DC analysis report:

1. Click the Reports tab.
r DC Results Overview E‘Eﬂ‘

| Sinks I Pins | WRMs I Vias | Reports |

SIPro/PIPro Setup =
[PI-DC] Analysis Report

m

< 1 |

3
[ SetTemplabes...] @ Save Report]

2. Click Save Report.

Setting Template

To set a template for your report, click the Set Templates button. Browse to the DocX, ODT, and HTML location for

selecting a template for your report.

83



SIPro and PIPro

Voltage

Clicking the Voltage option in the Results list loads the voltage plot. This is a scalar plot. The voltage is forced at O at the
negative pins of the VRMs.

w Layout EI@
View
VUL _JNU_ U], VUIbYE L V)
0 nis 03 045 0599 N749 NDRIG 108 12 & -+
.Y
]
\
. b
> .
-
b
-
Y
Aa
[
‘kr
L
| [vDD_GND_DC: Valtage ~ | [Hide Others | [ Unload ]
Setup Auto-Apply & Apply Revert
Range Automatic
Max L1976V
Layer lshow All v]
Het Type lshow All v]

Current Density

Clicking the Current Density option in the Results list loads the current density plot. This is a vector plot. The color

indicates the current density amplitude. The white arrow indicates the direction of the current. The arrow size is not an
indication for the current density amplitude.
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[ 4] Layout EI-E@
View
| Total Jc |:{A/mm*+2) =
0 16377 327.54 491.31 655.08 V\?} ﬂ
B3
¥
[

|[Ana|ysis 1]: Current Density hd |[ Hide Others ] [ Unload |
Setup V| Auto-Apply & Apply Revert
@ Automatic Custom | Update ScaleB Size Factor: 1.00 5+ V] Scale viectors
Range

Default Minimunm | 0 A/mm™=2
Default Maximum (55.082 A/mm™*2
Layer W
Net Type W

Power Loss Density

Clicking the Power Loss Density option in the Results list loads the power loss density. This is a scalar plot. This plot

shows the power loss per unit area.
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£ Layout

View

Area Power Density:(W/mm#++2)
i.5941e-27 0.095398 0.1908

k.

[[Analysis 1]: Power Loss Density - ][ Hide Others | [ Unload |

Setup Auto-Apply & Apply Rewvert

@ Automatic () Custom [¥] Update ScaleBar
Range

Default Minimum | 3.554062-27 W fmm*=2
Default Maximum | 0,254395 W /mm™*2

Layer [Show All - ]

Net Type [Show All - ]

Generate Schematic

Clicking the Generate Schematic option opens a Schematic window with the VRMs, Sinks, Component Models and an

SNP that points to the DC S-parameter model.

[ PC3-10600-UDIMM_PI-DC_Analysis 1 [PC2-10600-UDIMM:PC3-10600-UDIMM_PI-DC_Analysis Lischematic] (Schematic):l = | B S
File Edit Select View Insert Options Tools Layout Simulate Window Dynamiclink DesignGuide Add-Ons EM  Help
N el oD B —— o
EEEHO DOHA Y XD+ 8D (M- B e - O
Palette a8 x o i
e e
Lumped-Compane s o s oo =
R [OF S =t @=r Frimmom
B i1 o0 = s s oo s oo
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L
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=3
DiFeed -
= o EAT It
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=
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e ||
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See Also

® Setup Options for Customizing Results

PI-AC Dynamic IR Drop Analysis

PI-AC Dynamic IR Drop Analysis

® Creating a PI-AC Analysis Setup

® Viewing PI-AC Analysis Results

Creating a PI-AC Analysis Setup

A PI-AC analysis computes the impedance for the IC current loads over a broad frequency range. It helps you to identify
whether the power distribution network (PDN) provides a low impedance path from the Voltage Regulator Module (VRM)
to the IC. An excessive impedance in a certain frequency range can generate excessive voltage noise, also called dynamic
IR drop, when the IC power supply pins draw large amounts of transient current, required for 1/0 or core logic switching,

at rates that fall into that frequency range.

Defining a PI-AC Analysis Setup

You can create a PI-AC analysis setup in the following ways:
® Copying an existing PI-DC analysis setup.

® Creating a new PI-AC analysis setup.

Copying the PI-DC Analysis Setup

If you have already performed a PI-DC analysis, you can copy its setup for creating a PI-AC analysis setup. To copy an

existing setup:

1. Right-click the PI-DC analysis setup in the project panel.

2. Select Copy > To PI-AC Analysis.

5IPro/PIPro Setup 8 x
4 E Analyses |
B3] voo 6D Do
> VDD_GND_A( Highlight All
© [5] DQ_GND_ILL @ Run
' Scripts
£l Graphs + Copy... 4 + To Duplicate
[ Rename... ;2 | = ToPL-DC Analysis
Il Delete Del ==  ToPI-AC Analysis
+ To Power Plane Rescnance Analysis
¥ | Oer ' + To Power Aware SI Analysis
Tree .
_: Component Models 4
Create Script... 9
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Creating a New PI-AC Analysis Setup

If you want to create a new setup, right-click Analyses and then select New PI-AC Analysis. After creating a new setup,

you need to define VRMs and sinks. For more information, see PIPro Analysis Setup Overview.

Defining VRMs

To define a VRM:

1. Select a VRM (or connector) component instance in the Components list. You can also search the required

component. For more information about, see How to Find a Component Instance.

2. Drag and drop the selected instance on VRMSs in the AC Analysis list. A new VRM definition is added.

4 Analysis 5

4 — VRMs
o wrm_ll

- & Sinks

A Compeonent Models

"‘p Options..
% Run

» = Results

3. If the VRM connects to multiple power nets, the Select Net for Instance dialog box is displayed. Select a net.

Similarly, you can select ground nets.

Select Met for 11

Met Mame

VDD
VDDSPD
VREFCA
VREFDQ

T
Pins are connected to multiple Power nets. Please select a net to connect.
Pin Mames
J1197 01,194 11,191 J1.189 J1.186 J1.183 J1.182..
11.236
1167
il

OK ] [ Cancel

4. Double-click the VRM definition to open the VRM Editor dialog box.
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e

VRM Editer =N R[>

DC Voltage: 1.5V
A
Voltage Tolerance: 0 2% +
Resistance: 0 Chm ; V DC
Inductance: 0 mH — B
Reve Done ] | Cancel Apply

5. Specify the DC Voltage, Voltage Tolerance, and Resistance. The Inductance will not play a role for a DC analysis.
The Voltage Tolerance (absolute or in percent) is the voltage drop that is allowed at the output pins of the VRM.

There will be no voltage drop in the VRM in case the series resistance and inductance values are 0.

Defining Sinks
To define a sink:
1. Find the IC component instance(s) in the Components list.
2. Select the instance(s) and drag and drop them onto Sinks. New Sink definitions will be added in the tree.

3. In case the IC connects to multiple power nets, the Select Net for Instance dialog pops up where you will have to

select one.

4. In case multiple instances were dropped, the Select Net for Multiple Instances dialog provides a check box to Use

same Selection for All Sinks/VRMs. The same applies for ground nets.

5. Double click the Sink definition to open the Sink Editor dialog. Specify the DC Current, Resistance and Voltage
Tolerance. The Voltage Tolerance (absolute or in percent) is maximum voltage drop that is allowed at the input

pins of the IC.

Defining Component Models

For a PI-AC analysis, you need to consider the decoupling capacitors because they are not an open circuit at AC.

To define a component model:

1. Select the component group, which you want to analyze, in the Components list.
2. Drag and drop the component group on Component Models. The instances will be grouped by component name.

3. Define the electrical model parameters by using one of the following ways:
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b © Double-click the component instance to display the Component Model Editor window. For more

information, see Creating and Editing Component Models for Analysis.

© Alternatively, you can open the Vendor Parts database by selecting Tools > Vendor Parts DB. Drag and drop
the appropriate vendor part onto the component instance node (single model assignment) or onto the
component model group node (group model assignment). For more information, see Using Vendor Parts DB

Browser.

Defining Options

To define options, double-click Options in the PI-AC Analysis list in the project panel. provides It provides the following

options:

Option Description

Resolution Points closer than the specified resolution will be
considered equal during the simulation

Arc Resolution Value used to discretize circles and arcs during the
simulation

Custom Target Mesh Size Mesh size used to generate the global 3D mesh during
simulation

Use Ideal Ground Approximation When enabled, this option specifies that all Ground nets

are considered as ideal shorts. The power rail is often the
dominant contributor to the voltage drop. This option
provides you the capability to analyze this dominant

factor in less simulation time.

Defining Frequency Plans

By default, you can use the Automatic, Logarithmic and Adaptive frequency plan. The Automatic will provide the optimal

frequency sampling using a combination of Adaptive and Logarithmic sweeps.

Click the Frequency Plans tab to specify a plan.

Frequencies | Fields Storage |

()

Type Start Stop Points Step
| Automatic 10 kHz 300 MHz 300 (max - adaptive)

Saving fields for field plots

By default, the fields valued needed for visualization are not stored. You can enable this using the Field Storage dialog.
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=

I_ieqys!'_lg_n_a_s__: Fields Storage

Save fields for:

@ All Frequendies from the Freguency Flan and the Mesh Frequency
I Mo Field Data

| User Defined Frequencies

Note that this will save big files to disc. Depending on the example this can result in multiple GB of saved data.

Saving the Setup

Save your PI-AC analysis setup and double-click Run to start the PI-AC analysis.

Show Me How Do | Perform a PI-AC Analysis

Video: How to Perform a PI-AC Analysis

Viewing PI-AC Analysis Results

After creating a PI-AC analysis setup, you can run the analysis in the SIPro/PIPro Setup window. For a PI-AC analysis, the

following results are displayed:
® PDN Impedance
® S-parameters
® Electric Field
® Magnetic Field
® Current Density
® Generate Test Bench

® Generate Sub Circuit

Running a PI-AC Analysis

To run a PI-AC analysis and view results:

1. Save your PI-AC analysis setup.

2. Double-click Run to start the PI-AC analysis. The Simulations window is displayed, which allows you to monitor

and manage simulations:
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(i) Simulations EI@
®c@l e o
Id Name Date Created Engine Host Status
000001 Analysis1 Thu Apr 30 10:07:13 2015 FI-DC Local Queue Completed
000002 Analysis1 Wed May 6 10:33:32 2015 PI-DC Local Queue Completed
000003 Analysis1 Thu May 7 14:23:01 2015 PI-DC Local Queue Completed
000004 Analysis 4 Thu May 21 13:52:38 2015 PI-AC Local Queus Completed

Summary | Notes | Log Auto-scroll Update | | | Completed
-
sample frequency | nbUnknowns mem({GB) Elapsed time CEU time sclwver nblter
_____________________ | -
1 1.000 MHz | 273823 1.400 00:00:54.¢6 00:01:11.8 Dm&4
2 1.585 MH=z | 2738232 1.410 00:00:23.4 00:00:41.7 Cm&4d
3 Z2.51Z MHz | 273823 1.410 00:00:23.5 00:00:42 .0 Dme 4
4 3.381 MHz | 273823 1.410 00:00:23.4 00:00:41.39 Dm&4 F
5 &.310 MHz | 273823 1.410 00:00:23.4 00:00:-41.5 Cmé&4 ‘E‘
& 10.000 MHz | 273823 1.4Z20 00:00:23.2 00:00:41_4 Dme 4 —
7 15.84% MHz | 273823 1.420 00:00:23.2 00:00:41.5 Dm&4
-1 25.11% MHz | 273823 1.4Z20 00:00:25.5 00:00:-46.1 Cmé&4
3 35.811 MHz | 273823 1.430 00:00:25_4 00:00:50.5 Dme& 4
10 83.0%¢ MHz | z738z3 1.430 00:00:24.5 00:00:43.4 Dme4
11 100.000 MH=z | 273823 1.430 00:00:26.6 00:00:-47.1 Cmé&4 iR
17 1ce Aco Ww. e E T L 1] 1 azn An-nn-za a An-aAn-aa A Trmg A
4 i | 2

3. Expand the Results tree item.

4. Double-click the required result:

4 T Results

@
@
[

PDM Impedance
S-Parameters
Electric Field
Magnetic Field
Current Density

;'-'.TJ' Generate Test Bench...
Q'-'.Fl- Generate Sub Circuit...

PDN Impedance

A PI-AC analysis computes the impedance of the IC current loads over a broad frequency range. You can identify whether

the power distribution network (PDN) provides a low impedance path from the Voltage Regulator Module (VRM) to the

sinks or ICs. It provides the input impedance value from each sink.

Viewing PDN Impedance

To view PDN impedance results:

1. In the Results list, double-click PDN Impedance. The PDN impedance window is displayed.

2. Select the required sinks.

3. Right-click the selected sinks and choose Add PDN Impedance.
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Removing PDN Impedance Plots

To remove PDN Impedance plots:

1. Click the Plot tab.

2. Select the plots to be removed.

3. Click '

. The selected plots are deleted from the PDN Impedance window.

Importing a Target Impedance File

The PDN impedance window supports the import and visualization of target impedances. The following table lists the

contents of a sample CSV file:

Frequency[Hz]

100000

1000000

1000000

10000000

10000000

1E+08

1E+08

1E+09

Impedance[Ohm]

0.01

0.01

0.1

0.1

1.5

1.5
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Frequency[Hz] Impedance[Ohm]
1E+09 2

To import a series of target impedances:

1. Select File > Import Target Impedance. The Import Custom Target Impedance File dialog box is displayed.

2. Select a CSV file containing values. This file should contain comma separated frequency and impedance values.

The importer does not perform a validity check on the actual data.

3. Once imported, the values are added as a new plot on the impedance graph, as shown in the following figure:

e Export

VRM Open & VRMs Clos

“@ B

U0, sk U101 | PDN Impedance

01 12345678

Magnitude (ohm}

10 100 le+03
Frequency (MHz)

Result Type Options

In the Result Type section, you can select the following options:
® Impedance: Displays the PDN impedance values.
® S-Parameters: Displays the s parameter results.

The impedance plots show the PDN impedance values including the default component models specified in the setup.
After changing the default model specified in the Component Model Editor dialog (see Creating and Editing Component
Models for Analysis), you can update the impedance plots without recalculation. This allows a quick way to vary e.g.

decap component models and inspect the effect on the PDN plots.

VRM Options

If you are viewing Impedance results, you can also select the following VRMs options:

® Open
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®* Closed

Viewing Electric Field

Double-click Electric Field in the Results list of PI AC analysis. The electric field plot is displayed:

& Layout SRR (=X

View

No Plots:(dB) Reference value: 0.226523 V/m

V!

I | —
128.77103.8378.94:54.052291634.27320.61 M5.50670.396

5]

!

o
1

hk a0
.

[[Analysis 4]: Electric Field hd ][ Hide Others | [ Unload |

Setup & Apply Revert
@ Automatc 0 Custom Update ScaleBar

Range Excitation:

requenc

Default Minimum  &.584162-15V/m
Default Maximum |0.226523 V/m

LayerId |Show Al - ]

Viewing Magnetic Field

Double-click Magnetic Field in the Results list of PI AC analysis. The magnetic field plot is displayed:
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-90.419

-31.078

-1.4081

| [Analysis 4]: Magnetic Field

No Plots:(dB) Reference value: 7.93778 A/m
-60.749

28.262

~ | (HideOfhers} [ Unload |

| setup | auto-Apply M4 [ Apply | [ Revert |
@ Automatic ) Custom Update ScaleBar
Range Excitation: |sink_U2 -
reenc
Default Mini | 1.45155¢-05 Ajm |
Default | Masimum |7.33778 Ajm |
LayerId [Show Al -]

NOTE If you want to view only the recent results and hide previous analysis, click Hide Others.

Current Density

Double-click Current Density in the Results list of PI AC analysis.
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£ Layout
View
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| [Analysis 4]: Current Density

Setup
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- |E Hide Others § [ Unload |

V| Auto-Apply A Apply Rewvert

V| Update Scale Size Factor: 1.00 = |V Scale Vectors
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Frequency: |1MHz -
Default Minimum |0 A/mm**2
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Generating a Schematic

Double-click Generate Schematic in the Results list of PI-AC analysis. A Schematic window is displayed, which includes

the VRMs, Sinks, Component Models and an SNP that points to the S-parameter model.

sl PC3-10600-U DIMM_PI-AC_Analysis 4 [PC3-10600-UDIMM:PC3-10600-UDIMM_PI-AC_Analysis 4:schematic] (Schematic):3

File Edit Select View Insert Options Tools Layout Simulate Window Dynamiclink
== F B »
=EAT M H@ I
Palette & X

DesignGuide  Add-Ons  EM

H& 3 X999 &> (-] B>

Lumped-Compone

1 114l <

Select: Click and drag to select. 0 items. ads_devicedrawing 6.635, 0.625 6.625, 0.625 in
L

You can run a simulation from the schematic. The results display the input impedance for sinks, which is similar to the

SIPro/PIPro results.
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Enable the decoupling capacitors

The key parameter is the index, which determines the location of the switch. If the index is 0, the switch is open. If the
value of index is set to 1, the connection is made to the first part. Similarly, if the index is 2, then connection is made to
the second part. The following figure displays the results when the index value is set to 1:

per

AnE

1E1] ,

N m o . i . . . . - . s .
1 A ji5_3_CAF_2_2uF____10__SMCOR03_E 1 _500007=istl Cpien *Lumped 'GRM 1B5RA0U226KE 26" \GRM1BSCTO622

mag(Z(1,1)

mag(Z(3,3))
mag(Z(2,2))

2 uF__ 10 SMCOB03_511_S00007[CAR

603_51
1

MC0E03_5
10__SMCOB03 51

1E.2—

T T
1E6 1ET 1E8 5E8|

Tuning Parameters

To tune parameters:

1. Click theTuning icon. The TuneParameters dialog box is displayed.
2. Select the decoupling capacitor in Schematic.

Set the Minimum value to 0.

oW

Set the maximum value to 5.

5. Specify the Step value as 1.

.
I Tune Parameters ﬁ
S PC3-10600-UDIMM:PC 3-10600-UDIMM_PI-AC_Analysis 4:schematic
[While Slider Moves A ]
Tune
Parameters
[ Incude Opt Params ] s
| Enable/Disable... | (hm)
Value 5
[ snap slider to Step
Max 5
Traces and Values =
Trace Visibility...
[ Reset Values ]
[ Close All Data Display ]
Mi a
l IUpdate Schematic l "
Step 1
[ Close ] [ Help ] Scale Lin
L

6. Click the up and down arrows.

See Also

® Setup Options for Customizing Results
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PI-PPR Analysis

PI-PPR Analysis

® Creating a PI-PPR Analysis Setup

® Viewing PI-PPR Analysis Results

Creating a PI-PPR Analysis Setup

A PI-PPR (Power Plane Resonance) analysis computes the resonances of the design over a broad frequency range. It
helps you to identify the resonance frequencies and fields of the design, with and without components. It provides a
global view on natural modes (eigenmodes) between the power and ground planes. Some of the modes may cause
excessive impedance from VRM to IC. Some modes resonating around the signal frequencies may affect the signal

quality.

Defining a PI-PPR Analysis Setup

You can create a PI-PPR analysis setup in the following ways:
® Copying an existingPl-DC/AC analysis setup.

® Creating a new PI-PPR analysis setup.

Copying the PI DC/AC Analysis Setup

If you have already performed a PI-DC or PI-AC analysis, you can copy its setup for creating a PI-PPR analysis setup. To
copy an existing setup:
1. Right-click the existing PI-DC or PI-AC analysis setup in the project panel.

2. Select Copy > To PI-PPR Analysis. The entire setup is copied to create a new PI-PPR analysis setup.

Creating a New PI-PPR Analysis Setup

If you want to create a new setup, right-click Analyses and then select New PI-PPR Analysis.

Definition of VRMs and sinks are optional in PI-PPR. At least one VRM, or one sink or one
component is suggested to be defined to indicate the power and ground nets be put in PPR

simulation. For more information, see PIPro Analysis Setup Overview.

Defining VRMs

To define a VRM:
1. Select a VRM (or connector) component instance in the Parts tree. You can also search the required component.
For more information about, see How to Find a Component Instance.

2. Drag and drop the selected instance on the VRMs part in the project panel. A new VRM definition is added in the

project panel.
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3. If the VRM connects to multiple power nets, the Select Net for Instance dialog pops up where you will have to

select one. The same applies for ground nets.
4. Double-click the VRM definition to open the VRM Editor dialog box.

5. Specify the DC Voltage, Voltage Tolerance, and Resistance. The Inductance will not play a role for a DC analysis.
The Voltage Tolerance (absolute or in percent) is the voltage drop that is allowed at the output pins of the VRM.

There will be no voltage drop in the VRM in case the series resistance and inductance values are O.

Defining Sinks

To define a sink:

1. Find the IC component instance(s) in the Parts tree.
2. Select the instance(s) and drag and drop them onto Sinks. New Sink definitions will be added in the tree.

3. In case the IC connects to multiple power nets, the Select Net for Instance dialog pops up where you will have to

select one.

4. In case multiple instances were dropped, the Select Net for Multiple Instances dialog provides a check box to Use

same Selection for All Sinks/VRMs. The same applies for ground nets.

5. Double click the Sink definition to open the Sink Editor dialog. Specify the DC Current, Resistance and Voltage
Tolerance. The Voltage Tolerance (absolute or in percent) is maximum voltage drop that is allowed at the input

pins of the IC.

Defining Component Models

For a PI-PPR analysis, you need to consider the decoupling capacitors because the R, L and C parameters associated

with that component may affect the resonances.

To define a component model:

1. Select the component group, which you want to analyze, in the Components list.
2. Drag and drop the component group on Component Models. The instances will be grouped by component name.
3. Define the electrical model parameters by using one of the following ways:

a. Double-click the component instance to specify the electrical model parameters for that instance.

b. Alternatively, you can open the Vendor Parts database by selecting Tools > Vendor Parts DB. Drag and
drop the appropriate vendor part onto the component instance node (single model assignment) or onto
the component model group node (group model assignment). For more information, see Using Vendor

Parts DB Browser.

Defining Options

The same options can be set as for an PI-AC simulation.
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Defining Frequency Plan

There are three parameters in PPR frequency plan: Start frequency (Fstart), Stop frequency (Fstop), and Number of
eigenmodes (N). The first N modes with resonant frequencies between Fstart and Fstop would be provided. By default,
the Start and Stop frequencies are defined as minFreq and maxFreg. You can change the minFreq, maxFreq, by using the

Parameters window. For more information, see Parameters window.

Saving the Setup

Save your PI-PPR analysis setup and double-click Run to start the PI-PPR analysis.

Viewing PI-PPR Analysis Results

After creating a PI-PPR analysis setup, you can run the analysis in the SIPro/PIPro Setup window. For a PI-PPR analysis,

the following results are displayed:
® Electric Field
® Magnetic Field

® Current Density

Running a PI-PPR Analysis

To run a PI-PPR analysis and view results:

1. Save your PI-PPR analysis setup.

2. Double-click Run to start the PI-PPR analysis. The Simulations window is displayed, which allows you to monitor

and manage simulations.
3. Expand the Results tree item.

4. Double-click the required result:

4 Analysis 3
- VREMs
& Sinks
dr' Mets
A Component Models
“4. Options...
&5 Run
4 = Results
(W Electric Field
(B Magnetic Field

Current Density

Electric Field

Double-click Electric Field in the Results list of PI-PPR analysis. The electric field plot is displayed:
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& Layout

View

[F=N ({28 =)

No Plots:(dB) Reference value: 2.23041e4+09 V/m
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Setup |

Auto-Apply & Apply Revert
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Range
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Magnetic Field

Double-click Magnetic Field in the Results list of PI -PPR analysis. The magnetic field plot is displayed:

Frequency: |107.456 MHz -
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10 Layout =1 =R
View
No Plots:(dB) Reference value: 6.16036e+06 A/m
-115.79 -86.841 -57.894 -28.947 0 m:
l_q -
‘.' -
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=
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[
&
[[nnalysis 6]: Magnetic Field - ] [Hide Others ] [ unload |
Setup | Auto-Apply & Apply Revert
@ Automatic ) Custom Update ScaleBar
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Frequency:
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Current Density

Double-click Current Density in the Results list of PI-PPR analysis.
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& Layout
View

No Plots:(Afmm*+2)

0

1.9817e+06 39634e+06 5945le+06 7.9267e+0F
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See Also

® Setup Options for Customizing Results

/| Scale Vectors
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SIPro Analysis

SIPro Analysis

Contents

® Tutorial-Performing Power Aware S| Analysis
® Creating a Power Aware Sl Analysis Setup

® Viewing Power Aware S| Analysis Results

Tutorial-Performing Power Aware S| Analysis

In this tutorial, you will learn how to create a Power Aware Sl analysis setup, run the analysis, and view results. The
example workspace contains a Samsung DDR4 UDIMM memory card. The design files are downloaded from JEDEC (www.
jedec.com) and used for demonstration purposes. The example design consists of a 6 layer board with a single power rail

for core and 1/0 buffers, as shown in the following figure:

e —_— T

You can view the nets, components instances, and individual nets in the navigator window. The main power net passes

ik
A

from the conductor at the bottom of the design to the devices at the top. GND nets are present on the design. The
substrate pack consists of routing on the top and bottom layer. The power and GND nets are on layer 3 and 4. Before

performing the PIPro analysis, you need to know the names of the power and GND nets.

In this example design, the goal is to analyze the signal behavior of the critical line, including the effect of the GND

metallization.
The goal of Sl analysis is to provide an S-parameter model for the DQR15 line.

Example Workspace

exanpl es/ HSD/ SI Pro_Pl Pro_Getti ng_St arted_Exanpl e_w k. 7zads

Objective
® Set up a Power Aware Sl analysis
® Run the Power Aware Sl analysis

® View Power Aware Sl results (S-parameter and Generate Schematic)

Opening the Example Design

Open the SIPro_PIPro_Getting_Started_Example_wrk.7zads design. The Sl analysis setup data for a specific design is

stored in a cell view of the “SIPro/PIPro Setup”.
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To create a sipiSetup view, open the layout and select Tools > SIPro/PIPro > Open Setup.

If the sipiSetup view already exists, you can open it with a double-click in the ADS Main window.

4 | €| PC3-10600-UDIMM
layout
E; sipiSetup

The SIPro/PIPro Setup window is displayed.

Creating a Power Aware Sl Setup

In this example, you will create a new Sl analysis setup. To create a new setup, right-click Analyses and then select New

Sl Analysis.

Defining Ports

For an Sl analysis, you need to define ports that will be the ports of the S-parameters calculated by the tool. In this

example, you will define two ports, one on each side of the single DQR15 line.

To define a port:

1. Select the DQ15 line in the Nets tree.

4 PC4-RDIMM_V090_RC_FO_20131106_lib:P...
4 |7 Nets | ® DQ15

a P DQLS
Cr P 1662 11
v P2 RN20

In this example, you will use pins 6 and C2 to define the ports.

2. Drag and drop pin RN20 on the ports part of the tree.

4 Analysis 4 ,""l
4 7] Ports M
4 "1 1: DQ15_RN20 M
@ RN20.P_2:DQI5
a 5 Mets M
4T DQ15

N Component Models

By hovering over the exclamation mark, you will see that the GND reference for the port is not
defined. You can either manually select a GND pin and drag it to the port. Alternatively, you can
automatically find the closest GND pin by right-clicking 1: port and then selecting Add Nearby Pins To
Minus Terminal, which will add J1.P24 as the minus reference to the port:
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4 Analysis 4
4 :j Ports
SRR 1: Q15 RN20
@& RMN20.P_2:DQ15
@ J1.P_24: GND
a P DNets
O GND
dr DQ15

Two nets were automatically added to the list of nets: GND and DQ15. The metallization

associated with these nets will be included in the Power Aware Sl simulation.

3. Drag and drop pin J1 to the I/0 Ports part of the tree.

4. Right-click 2: DQ15_J1 and select Add Nearby Pins To Minus Terminal, which will add J1.P_165 as the minus

reference to the port:

4 Analysis 4
4 ::| Ports
4 1 1: DQI5_RN20
& RMN20.P_2:DQ15
@ J1.P_24: GND
TN 2 DQ15 1 |
© J1.P 166 : D015
@ J1.P_165: GND
a 7 Mets
O GND
dr DQ15

Defining Options
To define options:

1. Double-click Options in the Sl Analysis list.

2. Double-click in the Points field of the Adaptive frequency plan and type 150.

& Analysis 4

4 Frequency Plans

..

Type Start Stop Points Step
Adaptive 0 Hz 1 GHz 150 (max)

3. Click the Options tab.
4. Accept the default Resolution and Arc Resolution value.

5. Optionally, you can model the GND metallization as ideal PEC by selecting the ‘Use Ideal Ground Approximation’

option, which will result in a faster overall simulation.

6. Click Done.
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Running the Analysis

Save your Sl analysis setup and double-click Run to start the Sl analysis. The Simulations window is displayed and the Sl

analysis is initiated.

Viewing Results

After the analysis is complete, you can view results in the Results list. You can open the results during a simulation to

viewing the intermediate results.

To view the S-parameters results:

1. Double-click the S-Parameters option in the Results list.

2. Select the required nets in the Single-Ended section.

3. Right-click the selected nets and select Add Return Loss.

S-Parameters [DQ_GND_J1_UU19]
Data  Insert  Wiew

(®) xv Graph: |Magnitude ~ | () Smith Chart

PREOXR=FREG

Magnitude v. Frequency

1 A L
¢ T

-2 .

500 3.5e+03
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6e+03

[E=0 EE X5
Single Ended Mixed Mode
Nur')nber et Type Port o
Filter |Filter Filter
i Signal D001
2 Signal DO00R_U19
3 Signal DQ01_I1
04 Signal DQOTR_U19
5 Signal :DQ02_J1
6 Signal DQO2R_U19
*h 7 Ciminnl rEAn
£ >
12 345 6 7 8 910112 A
 Hl
|
3 L
4 [l
5 L
6 [l
7
]

(DQODIR_U19,DQS00_T_11)

View TDR/TDT Results

To View TDR/TDT results:

1. Double-click the TDR/TDT option in the Results list.
2. Select the required nets in the Single-Ended tab.

3. Right-click the selected nets and select Add TDR.
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S-Parameters [DQ_GND_J1_LU19]
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Show Me How Do | Perform a Power Aware Sl Analysis

Video: How to Perform a Power Aware Sl Analysis

Creating a Power Aware Sl Analysis Setup

A Power Aware Sl analysis enables you to compute the S-parameters over a broad frequency range for one or more

critical lines defined via I/0 ports in the setup.

Creating a New Power Aware Sl Analysis Setup

If you want to create a new setup, right-click Analyses and then select New Sl Analysis.

Alternatively, you can copy an existing analysis setup to create a new one.

Selecting Nets

To add nets to the Sl analysis node in the SIPro/PIPro setup:

1. Select the required nets in the Project panel:

4 | Nets | ® DQI5R
4 Jr' DOLSR
O B RNLO
O 201
O CRa U1

2. Right-click the nets and select Add to Analysis.

3. Select PA-SI Analysis as the target analysis.
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[ stPro/PIPro Setup () |

Select a target analysis

[PI-DC] Analysis 1
[P&-51] Analysis 4

Ok ] [ Cancel

4. Click OK. The selected nets are added to the Sl Analysis list.

Defining 1/0 Ports

The I/0 ports define the + and - terminals for the S-parameter ports in the Power Aware Sl simulation.

To define an I/0 Port:

1. Select the required nets in the Nets list of the SI Analysis node.

2. Right-click the selected nets and select Create Ports or Component Model Groups.

Select actions for Connected Compaonents @
Connected ComponentsTop Level Fins to Selected Signal Nets
Lib/Cell Instance Name Connected MNets Action

1 EPC4—RDIMM_V090_RC_FO...é 1 DQO0,0G01 ’Create Ports = l

2 PC4-RDIMM_V00_RC_FO... RN97 DQO0,0QO0R, DQOL, DQOLR lCreate Ports A l

3 PC4-RDIMM_VO30_RC_FO.., U19 DQOOR,DQOLR l(reate Ports = l
Ground Net for searching Pins for minus terminal

GND -]

O ] [ Cancel ]

3. To create a port, accept the default selection, Create Ports.

4. Click OK.

Alternatively, you can drag and drop pins. To define ports:

1. Drag a pin connected to the net that you want to model to the 1/0 Ports in the project panel. This will create a

new |/0 port with only the + connection defined.
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2. To complete the definition of this I/0 Port, drag a nearby pin connected to a GND or PWR net to the 1/0 Port
definition, or alternatively automatically connect the closest GND pin to the - terminal of the port by right-
clicking the Port and selecting Add Nearby Pins To Minus Terminal.

4 El Analysis 4
4 [ VO Ports
4 7 1:port
@ /1188 A0
@ U67:GND
4 [ 2uport2
© RMN30.1:AD
@ (54.2:GND
4 A Mets
O GMD
d Al

Component Models

“4. Options...
&% Run
Results

This operation will automatically populate the Nets list with the nets connected to the + and -

terminal.

Defining Component Models
Optionally, you can add components (series components such as resistors or decoupling capacitors) in the Sl analysis.

To define a component model:

1. Select the component group, which you want to analyze, in the Components list.
2. Drag and drop the component group on Component Models. The instances will be grouped by component name.
3. Define the electrical model parameters by using one of the following ways:

a. Double-click the component instance to specify the electrical model parameters for that instance.

b. Alternatively, you can open the Vendor Parts database by selecting Tools > Vendor Parts DB. Drag and
drop the appropriate vendor part onto the component instance node (single model assignment) or onto
the component model group node (group model assignment). For more information, see Using Vendor

Parts DB Browser.

Defining Options

To define options, double-click Options in the S| Analysis list in the project panel. It provides the following options:

Option Description

Resolution Points closer than the specified resolution will be

considered equal during the simulation
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Option Description

Arc Resolution Value used to discretize circles and arcs during the
simulation

Custom Target Mesh Size Mesh size used to generate the global 3D mesh during
simulation

Use Ideal Ground Approximation When enabled, this option specifies that all Ground nets

are considered as ideal shorts. The power rail is often the
dominant contributor to the voltage drop. This option
provides you the capability to analyze this dominant

factor in less simulation time.

Use Optimized Via Modeling Use via modeling settings optimized for simulation
performance.
Model Signal Return Currents in Coplanar Ground Ground metallization close to signal metallization is

included in the signal modeling during simulation

Defining Frequency Plans

Click the Frequency Plans tab to specify a plan.You can use the Automatic, Linear, Logarithmic and Adaptive frequency
plan. The Automatic uses a optimal combination of Adpative and Linear sweeps to cover the frequency range. The Start

frequency can be 0 Hz, the simulator will assume 1 kHz when 0 Hz is specified.

(+]

Type Start Stop Points
& Autornatic 0 Hz 1 GHz 300 (max - adaptive)

When using an Adaptive sweep for electrically long lines on a complex board, a large number of frequency points may be
required to reach convergence, specifically when a large number of signal lines is being analyzed. A linear frequency plan

setup is advised in this case.

To capture the dynamic behavior of a signal line when using a Linear sweep, you will need 10 frequency points per
wavelength, so in case the length of the signal line is 5 wavelengths, you will need 50 frequency points. This is typically

sufficient when using the SiPro generated S-parameter model in e.g. a transient or channel simulation.

Saving the Setup

Save your Sl analysis setup and double-click Run to start the Sl analysis.
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Viewing Power Aware S| Analysis Results

After creating an Sl analysis setup, you can run the analysis in the SIPro/PIPro Setup window. For an Sl analysis, the
following results are displayed:

® S-Parameters
® TDR/TDT

® Generate Sub Circuit

Running a Power Aware S| Analysis

To run an Sl analysis and view results:

1. Save your Sl analysis setup.

2. Double-click Run to start the Sl analysis. The Simulations window is displayed, which allows you to monitor and

manage simulations.
3. Expand the Results list:

4 DQ_GND_J1_U19
4 :j Ports
' Mets
> (M Component Models
“,. Options...
% Run
4 T Results
S-Parameters
=7 TDR/TODT
[ Generate Test Bench...
Ll Generate Sub Circuit..,

You can view S-parameters and generate a Schematic.

S-Parameters

To view the S-parameters results:

1. Double-click the S-Parameters option in the Results list. The S-Parameters window is displayed.
2. Select the required nets in the Single-Ended section.

3. Right-click the selected nets and select the required option such as, Add transmission.
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Using the S-Parameters Results Window

The S-Parameters window consists of the following menus:
¢ Data
® Insert

® \iew

Data

The Data menu provides the following options:
® Export : Exports the currently displayed plot to a text file.

® Save Plots as New Graph: Copies the current graph including plots and markers. It is saved in the Graphs node in
the project tree.

Insert

The Insert menu provides the following options:

® Point Marker: Insert a point marker in the graph.

[—2200 MHz, -1.9501 dB|

® (Crosshair Marker: Insert a crosshair marker.
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500

Horizontal Marker: Insert a horizontal marker.

Vertical Marker: Insert a vertical marker.

View

The View menu provides the following options:

Magnitude v. Frequency
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Frequency (MHz]

® Pan: Left-click on the graph and move mouse pointer to pan.

® Zoom: Left click on the graph and move mouse pointer to create a rectangle to zoom.

® Zoom to Extents: Zoom in or out to current plots so that they can fit into the graph.

* Export Image: Export plot image to a file.

Toolbar Options

The S-Parameters window provides several toolbar options for customizing the graph.

Icon

§ 3

1

¥

i

|

i

Y

}\r.l

Description

The Export Data icon enables you to export the currently

displayed plot to a text file.

The Export Image icon enables you to export the plot

image to a file.

The Zoom to Extents icon enables you to zoom in or out

to current plots so that they can fit into the graph.

The Pan icon enables you to move mouse pointer to pan.

The Zoom Tool icon enables you to move mouse pointer

to create a rectangle to zoom.
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Icon

4

Graph Type Selector
@ XY Graph: | Magnitude -

Description

The Legend Visible icon enables you to show or hide the

legends of the plots.

The Selection tool icon enables you to select items in a

plot.

The Point Marker Tool insert a point marker in the graph.

The Crosshair Marker icon inserts a crosshair marker.

The Horizontal Marker icon inserts a horizontal marker.

The Graph Properties icon displays the graph properties
pane. You can change graph appearance, and axis

controls.

You can set the following Graph Type Selector options to select a graph type:

¢ XY Graph Magnitude: Displays magnitude of the plots in the XY rectangular graph.

® XY Graph Phase: Displays phase of the plots in the XY rectangular graph.

¢ Smith Chart: Displays plots in the Smith chart.

Single Ended Tab

In the Single Ended tab, you can view the port properties, change the port impedance, and manipulate plots by right-

clicking on each row in the table.

Port Property Table

The Port Property Table shows various port properties in a table.
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blank.

Impedance context menu.

Number: Specifies to the S-parameter index.

Port: Port name that you define in the analysis tree

Number Met Type Port +MNet -Met Instance Pl
Filter Filter Filter Filter Filter Filter Filter
i I Signal DQO0_11 DQO0 GND n 50 ohm
i Signal DQOOR_U13 DQOOR GND 19 50 ohm
0o Signal DQo1_11 DQo1 GND 1 50 chm
i Signal DQO1R_U19 DQO1R GND U1g 50 ohm
hs Signal DGQoz_1 Qo2 GMND 1 50 ohm
We Signal DGQOZR_U19 DQOZR GMND Uig 50 ohm
i Signal DGo3_01 DQo3 GND 1 50 ohm
'hos Signal DQO3R_U19 DOO3R GND Uig 50 ohm
Mo Signal DQS00R_C_U19 DQSO0R_C GMD 19 50 chm
310 Signal DQS00R_T_U12 DQSOOR_T GMD 19 50 chm
M1 Signal DQS00_C_J1  DQS00_C  GND n 50 ohm
312 Signal DQS00_T_J1  DQS00_T  GND n 50 ohm

Net Type: Specifies whether the port's plus terminal connects to Signal nets or Power nets

+Net: Specifies the net name(s) that is connected to the plus terminal of the port.

-Net: Specifies the net name(s) that is connected to the minus terminal of the port.

You can perform the following tasks by right-clicking a port and selecting the required option:

Instance: Specifies the instance name(s) with which a port connected. For top level pins, this property becomes

Z: Specifies the port impedance. This property is editable. To edit, double-click the cell or select Specify Reference

® Viewing the Transmission plot : Right-click the selected port and then select Add transmission to display the

transmission characteristic(s) of selected port(s) to the graph. This feature will automatically find the other end of

connected link of the selected ports. This feature is convenient to check transmission characteristics for the

multiple lines.

117



SIPro and PIPro

S-Parameters [DQ_GND_J1_U19]
Data Insert View
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® Viewing the Return Loss: Right-click the selected port(s) and select Add return loss to display the return plot(s) of
selected port(s) to the graph.

S-Parameters [DQ_GND_11_U19]
Data Insert View

@ XY Graphs (© Smith Chart Single Ended | Mixed Mode
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® View the Insertion Loss: Right-click a net and then select Add Insertion Loss to display the insertion loss between
the selected two ports to the graph.

NOTE Insertion loss here does not necessarily mean "transmission". It means loss between any

of two ports.

® View Near End Crosstalk: Right-click a port and then select Add Near End Crosstalk to view the near end crosstalk
(s)of selected port(s) in the graph. This feature will automatically find all near end cross talk of the selected ports

with using Instance information.
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S-Parameters [DQ_GND_J1_U19]
Data Insert View
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® Add Far End Crosstalk : Add far end crosstalk(s) of selected port(s) to the graph. This feature will automatically

find all far end cross talk of the selected ports with using Instance information.

® Specify Reference Impedance : Set preferred reference impedance to the selected ports.

® Remove All Plots : Remove all plots from the graph.

Mixed Mode Tab

In the Mixed Mode tab, you can define differential pair of ports and add mixed mode plots in the graph in addition to most

of what you can do in the Single Ended tab.

Nur;ber Signal MNet Type Port +Net -Net Instance z
Filter |Fi|ter |Fi\ter |Fi|ter Filter |F\Iter |Fi|ter |Fi|ter |
i} SE Signal DQoo_11 DQOo GND i 50 chm
i SE Signal DQOOR_U19 DQOOR GND u19 50 ohm
s SE Signal DQo1_11 DQol GND n 50 ohm
e SE Signal DQO1R_U19 DQOIR GND U19 50 ohm
s SE Signal DQo2_11 DQoz GND hii 50 ohm
We SE Signal DQO2R_U19 DQO2R GND U19 50 ochm
i v SE Signal DQo3_ DQo3 GND i 50 ohm
i Signal DQO3R_U19 DQO3R GND uU1g 50 chm
i Signal DQS00R_C_U19|DQS00R_T_U19_D DQSO0R_C DQS00R_T U19 100
'3 10 C Signal DQS00R_C_U19|DQS00R_T_U19_C DQSO0R_C DQSO0R_T GND U19 25
Mt D Signal DQS00_C_J1|DQS00_T_J1_D DQS00_C DQS00_T I 100
iV o Signal DQS00_C_J1|DQS00_T_J1_C DQS00_CDQS00_T  GND a1 25

Port Property Table

In the Mixed Mode tab, Signal column is added to the ones for Single Ended table.

® Signal: Shows the type of the port.

© SE stands for Single Ended

© D stands for Differential

© C stands for Common.
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Context menus

In mixed mode tab, some context menus are added and some context menus are removed comparing to the one for

Single Ended tab.

Context menus only for Mixed Mode tab

* Make Differential Pairs: Make differential pairs for selected ports. This context menu works in two different ways

depending on how many ports you select in the table.

© If you select two ports in the table it means to create an differential pair for the selected two ports

explicitly. If selected ports are already a part of other differential pair that differential pair will be broken

before creating new differential pair.

© If you select more than two ports in the table it means to create multiple differential pairs for selected

ports. In this case differential pairs will be recognized and created automatically based on net names and

instance name with using predefined Differential Pair Recognition Rule. (See more detail here).

© In below example picture, selecting 4 ports and using Make Differential Pair for them will create two pairs

as follows.
Number Signal Net Type Port +MNet -Net Instance
Filter |:il'_er |:il'_er Filter |:ilter |:ilter |:iI:er
Signal DQ1_Rx DQ1 Gnd Rx
_j 2 SE Signal DQ1_Tx DO1 Gnd Tx
i} SE Signal DQ1# _Rx DQ1# Gnd Rx
ho4 SE Signal DQl#_Tx DQ1# Gnd Tx

© Port1 and 3 as a differential pair because these plus nets are DQ1 and DQ1# which are recognized as

differential pair by the recognition rule and also these are on the same instance Rx.

Port2 and 4 as a differential pair because these plus nets are DQ1 and DQ1# which are recognized as

differential pair by the recognition rule and also these are on the same instance Tx.

* Break Differential Pairs : Break existing pairs for selected ports.

Context menus not available for Mixed Mode tab

® Add Near End Crosstalk

® Add Far End Crosstalk

View Mixed Mode S-parameters

® View Return Loss : Use Add Return Loss context menu on desired ports.

Number Signal Net Type Port +Net -Net Instance
Filter |:il'.er |:il'.er Filter |:iI:er |:iI:er |:il:er
Signal DQ1_Rx|DQ1#_Rx D DO1 DO1# Rx
Signal DQ1_Tx|DO1#_Tx_D DO1 DQ1# Tx
Signal DQ1_Rx|DQ1#_Rx_C DQ1 DQl# Gnd R
Signal DQ1_Tx|DQ1#_Tx_C D01 DQ1# Gnd T

® View Insertion Loss : Use Add Insertion Loss context menu on desired two ports that you want to view insertion

loss in between. ( Note: term of "Insertion Loss" doesn't necessarily mean insertion loss of physically connected

link. )
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Matrix Selector

Matrix Selector allows you to select add/remove plots based on S-parameter index.
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View TDR/TDT Results

To view TDR/TDT results:

1. Double-click the TDR/TDT option in the Results list.
2. Select the required nets in the Single-Ended section.

3. Right-click the selected nets and select the required option such as, Add TDR.
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Using the TDR/TDT Results Window

The TDR/TDT window consists of the following menus:

® Export

Export

The Export menu provides the following options:
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® Save Plots as New Graph: Copies the current graph including plots and markers. It is saved in the Graphs node in

the project tree.

Toolbar Options

The TDR/TDT window provides several toolbar options for customizing the graph. See Toolbar Options section in the

Using the S-Parameters Results Window for more detail.

TDR/TDT Setup Options

Start Time: 0 nz Stop Time: §ns Delay: 1nz Samples: 301
Result Type: Respanse Type: Pulse Width: 1 s Window: (8510 6.0 -

Start Time : Specify start time.

Stop Time : Specify stop time.

Delay : Specify delay value.

Samples : Specify number of data samples in time domain.

Result Type : Specify Y-axis unit in either Impedance or Voltage.

Response Type : Specify response type either Step or Pulse.

Pulse Width : Specify pulse width for Pulse Response Type. This value is ignored in Step Response Type.

Window : Specify window type

Single Ended Tab

In the Single Ended tab, you can view the port properties, change the port impedance, and manipulate plots by right-

clicking on each row in the table.

Nur:'ll:ter Met Type Port +MNet -MNet Instance z
Filter Filter Filter Filter Filter Filter Filter
i Signal DQO0_11 DQOO GND 1 50 ochm
i Signal DQOOR_U19 DQOOR GND 19 50 ohm
hos Signal Doo1_11 DQo1 GND n 50 ohm
h4 Signal DQO1R_U1% DQOIR GND 19 50 ohm
i Signal DQoz_11 DQo2 GND n 50 ohm
‘De Signal DQOZR_U13 DQOZR GND 19 50 ohm
i Signal DQo3_n DQo3 GND 1 50 chm
hos Signal DQO3R_U19 DQO3R GND U1g 50 ohm
he Signal DQS00R_C_U19 DQSO0R_C GMD U19 50 chm
3 10 Signal DQS00R_T_U19 DQSOOR_T GMD U19 50 chm
MigEb Signal DGQsS00_C_J1 DQS00_C  GND 1 50 ohm
i Signal DGS00_T_J1 DOSO0_T  GND hi| 50 ohm

Port Property Table

The Port Property Table shows various port properties in a table. See Port Property Table section in the Using the S-

Parameters Results Window for more detail of table contents.

You can perform the following tasks by right-clicking a port and selecting the required option:
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® Viewing the TDT plot : Right-click the selected port and then select Add TDT to display the TDT characteristic(s) of
selected port(s) to the graph. This feature will automatically find the other end of connected link of the selected

ports. This feature is convenient to check transmission characteristics for the multiple lines.

® Viewing the TDR plot : Right-click the selected port and then select Add TDR to display the TDR characteristic(s)
of selected port(s) to the graph.

* Specify Reference Impedance : Set preferred reference impedance to the selected ports.

* Remove All Plots : Remove all plots from the graph.

Mixed Mode Tab

In the Mixed Mode tab, you can define differential pair of ports and add mixed mode plots in the graph in addition to most

of what you can do in the Single Ended tab.

Number Signal MNet Type Port +Net -Net Instance zZ

Ml SE Signal DQoo_11 DQoo GND i 50 ohm
02 SE Signal DQOOR_U19 DQOOR GND uU1g 50 ohm
s SE Signal DQo1_11 DQol GND n 50 chm
M SE Signal DQO1R_U19 DQOIR GND U19 50 chm
s SE Signal DQo2_11 DQo2 GND i 50 chm
‘i SE Signal DQO2R_U19 DQOZR GND u19 50 ohm
il SE Signal DQo3_11 Qo3 GND n 50 ohm
‘Ie SE Signal DQO3R_U19 DQO3R GND U19 50 ohm

o DQS00R_C_U19|DQSO0R_T_U19_D DQSOOR_C DQS00R_T U109 100

- 10 " Signal DQS00R_C_U19|DQS00R_T_U19_C DQSO0R_C DQSO0R_T GND U19 25

il D Signal DQS00_C_J1|DQS00_T_J1_D DQS00_C DQS00_T I 100

- 12 o Signal DQS00_C_J1|DQS00_T_J1_C DQS00_CDQS00_T  GND a1 25

Port Property Table

In the Mixed Mode tab, Signal column is added to the ones for Single Ended table.
¢ Signal: Shows the type of the port.
© SE stands for Single Ended
© D stands for Differential
© C stands for Common.
In mixed mode tab, following context menus are added comparing to the one for Single Ended tab.

* Make Differential Pairs: Make differential pairs for selected ports. See the same section in the Using the S-
Parameters Results Window.

* Break Differential Pairs : Break existing pairs for selected ports. See the same section in the Using the S-

Parameters Results Window.

Matrix Selector

Matrix Selector allows you to select add/remove plots based on S-parameter index.
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Generate Sub Circuit

Double-click Generate Sub Circuit in the Results list. A Schematic window is displayed, as shown in the following figure:
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Installing the Deprecated Sl and Pl
Analysis Addon

The legacy SI/PI analyzer is still available, but is a deprecated solution. Please use SIPro or
PIPro instead, see Getting Started with SIPro and PIPro. This addon will no longer be available in

the future major releases of ADS.

Installing the Deprecated Sl and Pl Analysis Addon

The legacy SI/PI analyzer is available as an addon. The SI/PI Analyzer addon assists in setting up Sl or PI EM and circuit

simulations. This addon consists of two parts:

® Setup wizard: The setup wizard guides you through the process of creating a new cell that contains only selected

nets (physical interconnects) to be analyzed. The output of the setup wizard is a cell that is ready for EM analysis.

® Analysis guide: The analysis guide assists in setting up typical Sl or PI circuit simulation testbench. The output of
the analysis guide is a circuit schematic, ready to be simulated, a data display template that captures relevant

output figures. In addition, the analysis guide supports Momentum current visualization based on the results.

To install the Sl and Pl Analyzer addon:

—_

. Select Tools > App Manager in the ADS Main window.
Click Add User ADS Addon. The Add User Addon dialog box is displayed.

Click Browse.

P L n

Access the $HPEESOF_DIR/ael_addons/sipi_deprecated/ael folder.
5. Select the PhysSipi_boot.atf file and click Open.
6. Click OK. The PhysSipi_boot option is displayed in the User Addons list.

7. Select the Enabled check box for PhysSipi_boot, as shown in the following figure:
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8. Click Yes in the message box.

9. Click OK in the message box.

10. Click Close in the App Manager window.

11. Open a Layout window. The SI/PI Analyzer addon is displayed in the menu bar, as shown in the following figure:

Add-Ons IS]IP]AnaIyzer Adfi Tools  Help

) & 2

Setup...
Analysis...
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SIPro/PIPro Videos
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Perform a PI-DC Analysis

This video talks about how to perform a PI-DC analysis.

Perform a Power Aware S| Analysis

This video talks about how to perform a Power Aware Sl analysis.
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Perform a PI-AC Analysis

This video talks about how to perform a PI-AC analysis.
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